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Welcome to Kudo Image Browser

Kudo Image Browser  is used to create, edit, read and use portable thumbnail image catalogs.    The collection manager 
uses Kudo image catalogs to publish and manage image, media and document file collections.    

Most people use Kudo Internet Multimedia Suite for doing batch operations on groups of image files. Kudo Image Browser 
makes it easy to select a group of images and perform operations on the group.    These operations are initiated by selecting 
commands from the Kudo Image Browser menu and toolbar buttons or via keyboard shortcuts and special mouse commands. All 
batch operations can be stopped by pressing the Esc key.
Kudo Image Browser users can manage and publish catalogs representing an unlimited number of image, media and office 
document files on local and remote file systems. 

What it does

Drop image and media files on Kudo Image Browser  to automatically create indexed thumbnail catalogs. The original 
file remains untouched in its original form and location. 

During the catalog creation process, useful text information, such as the original file's name, location, path and URL, size, file 
type, and modification date is added automatically. Image properties such as dimensions, color depth, and resolution as well as 
error messages, are inserted, too. 
After the catalog thumbnail records are created you can manually add keywords and freeform text notes to make identification 
and searching easier. Searches are fast because Kudo indexes all the filenames and text notes automatically. 

Tools in Kudo Image Browser  let you perform batch edits of catalog records, perform search and replace text 
operations, manage (select, copy, move, delete & rename) linked files, create catalogs from the found set of records, create 
HTML pages, create slide shows and screensavers, create play lists, change thumbnails to icons and .BMP files, and convert 
images to wallpaper. 

Clicking on thumbnails with the right mouse button displays the linked image file in the Kudo Imager Viewer .    The 
Kudo Image Viewer features include multiple image display, batch image conversion, annotation, resizing, editing, slide shows
and screensavers.

To view remote files, Kudo Image Browser  invokes Kudo Internet File Browser 

, a separate FTP/HTTP client, to access the URL, get the file and display it in the Kudo Image Viewer 

.    Double left clicking on thumbnails linked to URLs opens the URL in the default Internet browser. 

Kudo Image Browser  v5 has many new features to help Internet surfers and publishers create and use image catalogs. 
Surfers can create visual catalogs of their Internet image booty and favorite Web sites. Surfers can easily create and use catalogs
of images and media files on FTP or Web Sites.      Web publishers can export image catalogs to HTML and publish catalogs on 
their Web site.    Kudo can also make image catalogs of Web pages and create an exciting and useful new view of the Internet.

The professional Webmaster/Publisher can use the Kudo FTP/HTTP client to perform Web site maintenance operations 
including copy, rename, delete, move, view and add to Kudo catalog.    Seamless integration between local and remote file 

systems and the copycat File Explorer interface makes the operation of the Kudo Internet File Browser  easy and 
obvious.    The Kudo Internet File Browser also displays the Web page links in a useful list view.

Viewing the contents of a Web site in a Kudo catalog can provide a useful and interesting perspective to the site designer.    
Kudo users can see hundreds of Web page previews on a single screen.    Visually oriented Web designers benefit from this 
unique, completely horizontal view of the site.    This horizontal view provides a useful counterpoint to the vertical linked view 



of the Internet Explorer. 

Creating separate catalogs of the same Web sites via FTP and HTTP and comparing the catalogs can provide quick visual 
comparative information about file linkage problems and unsightly page style differences. 



What's New

What’s New in This release:

Improved HTML Export command now supports creation of HTML pages that have smaller thumbnail images.    Added JPEG 
(Low, Medium and High quality) file format to the thumbnail image options.    The resulting HTML pages are 3 to 5 times 
smaller in file size. Smaller file size improves Web page loading time.

Added HTML file support to the Kudo startup screen and splash screen files. You can now customize your Kudo catalogs with 
your own HTML, AVI, BMP and WAV files. 

Opening an old style KDB catalog is now much easier.    Drag and drop the KDB catalog onto the open Kudo Image Browser 
title bar to open it. 

Improved support for larger catalogs (>40,000 records).      Although it is possible to make catalogs containing more than 50,000
records, it is easier to use smaller catalogs (<20,00 records) that contain records segmented by meaningful categories. Catalog 
files that exceed 150 Mbytes are unwieldy. The smaller catalogs can be combined in an index catalog to support an unlimited 
number of records. 

The new Find Range of Records search command in the Find dialog helps you to create a found set from a contiguous group of 
thumbnails.    The Find Range of Records command is instantaneous and especially useful when you want to perform batch 
operations on a subset of a large catalog. 

Inserting the linked image file into application documents via drag and drop from the catalog is improved.    Kudo automatically
performs File Manager drop onto and OLE2 drag and drop of the linked images into Word, PowerPoint, Publisher, Excel, 
WordPerfect, PageMaker, Draw, Illustrator, PhotoShop and all OLE2 enabled applications. Drag and drop into Microsoft 
Office applications requires you to hold down the Ctrl key during the operation.

Marking single records – select individual records for further processing with  or Alt+left mouse click.    Note that Ctrl+left 
mouse shortcut has been changed to Alt+left mouse click.

Tree View  displays the volumes, folders and files in the catalog.    This view of the catalog is similar to the File Explorer 
detail view.      The Tree View simplifies catalog navigation and complements the other three catalog views. 
Move File Structure moves the selected folder, all nested folders and files in the catalog and updates the catalog with the new 
location.    Simplifies moving selected linked files to new folders.    The Move File Structure command is in the Edit Found Set
Move menu.

Copy File Structure makes a copy of the selected folder, all nested folders and files to a destination folder. Simplifies copying 
selected portions of an image catalog’s file structure.    The Copy File Structure command is in the Edit Found Set Copy menu.
Does not change the catalog.

Replace Part of Path changes the file location field of all records that contain the selected folder and all nested folders.    The 
Replace Part of Path command performs a search and replace operation on the file Location field. Simplifies updating a 
catalog after using the Copy File Structure command to copy portions of an image catalog’s structure.    The Replace Part of 
Path is best used on a copy of the master catalog after using the Copy File Structure command.    Access this command from the
Edit Found Set Change File Location menu.

New Kudo Image Publisher features allow Kudo CD-ROM users to run slide shows , screensavers 

 and open catalogs 

 without installing Kudo to the hard disk.
Kudo Image Publisher users can now create Kudo CD-ROMs that automatically start by opening an HTML, PDF or AVI file.
Play a WAV file when you view an image.    The WAV file with the same filename as the image will play when the image is 

displayed in the Kudo Image Viewer .
Get All Images From URL automatically downloads the linked files from the Internet. This batch download occurs in the 
background.    Puts the files in the folder shown in the record’s Location field. This is a very fast download.



The Kudo Image Viewer Show All Images command has been improved. 

What’s New in Previous v5 releases:

· Create Slide Show list – Make image and media file playlists for named slide shows. 

· Marking groups of records – select groups of records for further processing with Shift+left mouse click.

· Import Mac Kudo catalog – opens and converts Mac Kudo catalogs to new style KDN catalogs.

· Context-sensitive help.    Press F1  when you want help and the help topic associated with the menu item will appear. 
Press the What’s This 

 help button and click the What’s This 

 cursor on any button or menu to get the associated help topic. 

· Kudo Image Browser  now has a complete set of new features for catalog editing and file management.    

· Kudo Image Viewer  and Kudo Image Browser 

 now can access images, multimedia content and Internet documents over the Internet. 
· Drag and drop to catalog Internet files and links from the Internet Explorer window, Favorites folder, History folder and 

Temporary Internet Files folder. 

· New cataloging and viewing technology for creating Kudo image thumbnails of Adobe Acrobat and PostScript fonts, 
Microsoft Office documents, other popular file formats and Flashpix.

· Many popular and familiar Kudo Image Browser  for Macintosh features have been ported to v5.

· Cluster of features for helping Internet surfers create and enjoy multimedia file collections obtained from the Internet.

· Cluster of features for helping Internet publishers create and maintain content rich sites.

· New Info View with editable Notes field that use traditional editing commands.

· New single button slideshow  and screensaver 

.
· New text Search and Replace in notes field

· New Add Keywords to found set

· New View All Images feature that displays all the image files in the found set

· New Notes Field preferences for selecting image information import during cataloging

· New Create Catalog from found set

· New Verify Catalog found set

· New Export Catalog to Macintosh feature



Starting an Image Collection
This topic describes how to create your own image collection from digital photos, clip art CDs or from the Internet. 

To create a digital image collection you need images, storage media and an image catalog and management system. 

Digital image sources are your digital camera, the Internet, scanning printed images, grabbing frames from video clips or from 
your image editing/drawing programs 

Give your images meaningful names. To make finding and collection management chores easier, put your images into folders 
with meaningful names.    Use the source, categorical description (animal, plant, mineral, Hong_Kong_trip…) or other common
image characteristic as the folder name. 

Store your digital images on your computer’s hard disk.    As your storage needs grow you will want to put your image 
collection on CD-ROMs.

Use Kudo thumbnail image catalogs to organize, find and manage your collection.    Make separate catalogs of your vacation 
images, wedding images, Internet images and work images. 

To make a Kudo catalog from your image collection, drag and drop the folders containing images onto the open Kudo Image 
Browser window or icon. Give your catalog a meaningful name. The catalog can contain image records that are linked to files 
on your computer disk drives, CD-ROMs, Zip or Jaz cartridges. Kudo can also catalog files on the Internet.

The easiest way to find images is to visually browse the Kudo thumbnail catalog that you have made from your image 
collection.    It is also easy to search for images in your catalog by location (folder name), file name or keywords that you add to
the Notes field.

Open your catalog and browse it by clicking on the scroll bar. When you have found an image that you like, click on it to view 
it, Alt+leftmouse click to mark it or drag and drop it into a document window to print it. 

When it takes you too long to find an image by scrolling, your catalog needs to be segmented into sub-categories. The easiest 
way to segment your catalog is to move selected images to sub-folders that have meaningful category names.    Decide on 5 or 
more category names for the sub-folders. 

Mark selected images with a Alt+leftmouse click.    Find all marked records and use the Move Image Files command from the 
Kudo Image Browser Edit Found Set menu to move all the linked image files to a new folder.    The new folder should have 
the new category name. Mac users use the Move Marked Files script. 

Unmark the records by Shift+left clicking on the first and last marked record in the found set. Repeat this operation for each 
category name. Mac users use the Unmark All script. 

When you are done moving files into new locations, create a found set of thumbnails that you can easily browse.    Use Find to 
search for the new file locations. 

Use the same sequence of steps to add keywords to your catalog except use the Edit Found Set Add Keywords instead of the 
Move Image Files commands. 



Kudo Catalog Properties

The catalogs that you create with Kudo Image Browser  have many easy to use and helpful features that add value to 
your media collection.    Some of the advanced features are only available if you have an Internet connection or a Kudo Image 
Publisher license.

· Instant access to your images, movies, sound clips and text documents on Macintosh and PowerMac, Windows 3.1, 
Windows 95 and Windows NT4 workstations.

· Launch the creator or associated applications (Web browser, editor, player..) directly from your catalog.

· Select a thumbnail image and drag it onto an open document for instant placement. 

· Find and sort multimedia files by file name, file type, file location, size and more. Use =, >, <, and contains, is, or is not 
to facilitate searches.

· Instantly view, print, convert or play image, multimedia, Web pages and text documents without leaving Kudo.    

· Automate many common desktop publishing and Web page publishing operations.

· Manage your Web site favorites and Internet shortcuts and get instant access to selected Web pages or URLs.



Kudo Image Browser and the Internet

Kudo Image Browser  has many new features to help Internet surfers and publishers. Internet surfers can create visual 
catalogs of their Internet image booty and favorite Web sites. Surfers can create and use catalogs of images and media files on 
FTP or Web Sites.      Web publishers can export image catalogs to HTML and access the Kudo search engine to search catalogs 
published on the Internet.    

Kudo image catalogs of Web pages provide an exciting new visual interface to the Internet.    
Kudo helps Internet surfers, Web site developers and publishers simplify and automate common repetitive tasks via the famous 
Kudo thumbnail image cataloging technology.    Web pages, Internet shortcuts, image, media and document files on remote file 

systems can now processed by Kudo Image Browser  and Kudo Image Viewer 

.

Clicking on thumbnail with the right mouse button displays the linked file in the Kudo Image Viewer .    If the image is 
not on the local file system Kudo will get the file from the Internet and display it. 
Clicking on a thumbnail with the left mouse button opens the URL in the default Internet browser. 

Viewing the contents of a Web site in a Kudo catalog can provide a useful and interesting perspective to the site designer.    
Kudo users can see hundreds of Web page previews on a single screen.    Visually oriented Web designers benefit from this 
unique, completely horizontal view of the site.    This horizontal view provides a useful counterpoint to the vertical linked view 
of the Internet Explorer. 

Compare FTP URL catalogs and HTTP URL catalogs of the same Web site to gain quick visual comparative information about 
file linkage problems and unsightly page style differences. 

Drop the Netscape or Internet Explorer cache or history folder on the open Kudo window and watch as Kudo creates visual 
catalogs of your recently visited Web sites. This may surprise you!

Put Kudo image catalogs on your Web site and watch as your users enjoy amazing interactive journeys through the catalogs.    
Visit http://imspace.com/newcats.htm to experience Kudo Internet catalogs. 

Collections of the new file formats supported by Kudo can be automatically and instantly published on a remote or local file 
system.    Anyone with access to a Web site can now easily share image, media or document file collections.

Workgroups that use corporate, government or educational Intranets or local area networks can use image catalogs to make 
shared media file collections more useful and enjoyable.



Installing, Upgrading and Uninstalling Kudo Image Browser

Kudo Image Browser  is installed and uninstalled as a component of the Kudo Internet Multimedia Suite or Kudo 
Image Publisher v5. Use the Add/Remove Programs selection of the Control Panel to uninstall the Kudo Internet 
Multimedia Suite.      The uninstall function will not remove your catalog or image files.



Kudo Menus
Visit the Kudo menu topics listed below for more information. 

File Menu 

Edit Record Menu 

Edit Found Set 

View Menu 

Sort Menu 

Tools Menu 

 CD Publisher 

Window Menu 

Help Menu 



File Menu
Visit the Kudo File menu command topics listed below for more information. 

Creating a    New Catalog 

Creating An Internet Catalog

Opening a Catalog 

Open a KDB Catalog 

Close Catalog 

Save Catalog As 

Add Images to a Catalog 

Printing Your Catalog 

Print Preview 

Print Setup 

Exit 
Recently Used Catalogs 



Creating a New Catalog
§ Create a new catalog by dropping folders or files from the Windows File Explorer onto the Kudo Image Browser title bar.   

If there is no catalog open you can drop the folders or files anywhere on the open Kudo window. 

§ To create a new catalog from the open Kudo Image Browser window, click on the File New menu option, select the 
C:/KudoIMS5/Catalog folder location, enter a new catalog name and click on Open.    Select the folders or files to put in 
the catalog from the left side of the Windows File Explorer.    Drag and drop your selected folders or image, media and 
document files on to the open Kudo window and watch Kudo create a catalog. 

§ To create a catalog on the desktop, right click on the Windows desktop. Select New, scroll down and click on the Kudo50 
File Type selection.    This creates a catalog with the default name New Kudo50 File Type.KDN.    Double clicking this 

catalog file opens Kudo Image Browser . 

§ Create a new catalog by choosing the Catalog All Open Images or Catalog One Image selection from the Tools menu of 

the Kudo Image Viewer .

§ Create a new catalog by choosing Catalog Selected Images from the Tools menu of the Kudo Internet File Browser

. 

To make a new catalog you need to have Kudo Internet Multimedia Suite registered version or be in the evaluation mode of 
Kudo Internet Multimedia Suite.    If you are in the Catalog Reader mode of Kudo Internet Multimedia Suite you can only
read Kudo catalogs.    

Visit Creating An Internet Catalog, Updating a catalog and Kudo Catalog Properties for associated information. 



Creating An Internet Catalog
An Internet catalog is a Kudo catalog that has a URL link in the Notes field of the thumbnail records.    The records that have 
URL links in the Notes field can get the image from the URL with the help of Internet Explorer, Netscape Navigator or Kudo
Internet File Browser.    Double left clicking will open the URL in the default browser if the image file is not on the local 
system.    Right clicking will download and open the image in the Kudo Image Viewer if the file is not on the local system.

To create an Internet catalog, add the URL to the Notes field of an existing catalog or use Kudo Internet File Browser to 
automatically create a new Internet catalog.

To add the URL to the Notes field of an existing catalog:

· Open the catalog and select a record.    

· Open the thumbnail editor via the Edit Thumbnail Info selection of the Edit Record menu.    

· Add URL: http://www.mydomain.com/filesdirectory/myfile.xxx to the first line of the Notes field.    Closing the editor 
writes the new text to the record.    Remember that letter case is important on most UNIX systems.

Kudo Image Browser will automatically add the URL information to the new record if you use drag and drop to add Internet 
files from the Internet Explorer window, Favorites folder, History folder or Temporary Internet Files folder to a catalog. 

To create an Internet catalog of files from the Internet with Kudo Internet File Browser:

· Open Kudo Internet File Browser and select Connect to FTP or Connect to HTTP from the Tools menu.    

· Enter the FTP directory URL or the HTTP page URL that has the files you want to catalog.    

· Enter the local path for storing the downloaded files. 

· Check the Use this Folder for all Downloads box.    

· Click on OK to open the connection.

· When you are connected to the remote file system, select files to catalog from the right side of the Kudo Internet File 
Browser window. Use the same selection techniques as used with the Windows File Explorer.    One left click selects.    
Select more files with a second left click requires you to hold down the Ctrl or Shift key.

· Click on the Catalog Selected Images toolbar button to begin the automatic process of downloading and cataloging.    If 
you have a catalog open, the downloaded files will be added. Kudo Image Browser will ask you to create a new catalog if
none is open.

Web pages and FTP directories appear as folders on the left side of the Kudo Internet File Browser window. All files linked to
an HTML page appear as line items on the right side of the Kudo Internet File Browser window.    All files in an FTP 
directory appear as line items on the right side of the Kudo Internet File Browser window.    

Clicking on a thumbnail whose linked file is not in the local path shown in the Location field, results in the following behavior:

· Double left clicking on a thumbnail opens your default Internet Browser with the linked file.    

· Right clicking on a thumbnail causes Kudo to ask you if you want to get the file from the Internet. 



Opening a Catalog

To open a Kudo catalog .

§ Select a catalog  and double click it from the Windows desktop or the Windows File Explorer.

§ Select a catalog , drag it onto the Kudo Image Browser title bar and drop it.

§ Click on Open from the Kudo Image Browser File menu or click on  and select a catalog 

 from the Open Catalog dialog.    
Repeat the above steps to open multiple catalogs. Each catalog appears in its own window. 

Catalogs default to maximum size in Gallery  view when opened.

The Kudo Image Browser main window defaults to the last window size and location when opened after an orderly exit. 

If the catalog does not have a Turbo Search Table (.HSN)     file then a new one will be created during the catalog 
opening process.    If you will be making lots of changes you can cancel this operation.

If the catalog was damaged or crashed, then Kudo Image Browser  will rebuild the record index during the catalog 
opening process.    You cannot cancel the record index rebuild operation.



Opening a KDB Catalog

KDB catalogs are made with older versions of Kudo Image Browser  for Windows.    The letters KDB refer to the three-
character catalog file suffix also called the file extension.    To change your File Explorer settings to show the file extension, 
open the Options selection in the Explorer View menu and select the View tab.

To open a KDB catalog:
· Drag the KDB catalog from the File Explorer and drop it on the open Kudo Image Browser title bar or icon.

· Select Open .KDB Catalog from the Kudo Image Browser File menu.    A Select the .KDB Catalog to Open dialog will 
appear. 

The process of opening the KDB catalog involves conversion to the new KDN format. Opening the catalog begins the process 
of converting the old style catalog to the new KDN format.    The new KDN version of the old catalog is automatically saved in 
the /KudoIMS5/Catalogs folder.    The old catalog remains in its original location.

Use the Refresh All Thumbnails selection in the Edit Found Set menu to improve the quality of the thumbnail images in the 
converted catalog. 



Close Catalog
Closes the current catalog and compacts the catalog records if more than 10 percent of the records have changed.    



Save Catalog As
Makes a duplicate of the current catalog and saves it to disk with another path or name.



Add Images to a Catalog
To add files to a catalog:

· Drop the files, folders or shortcuts on the title bar of the open catalog  window. 

· Choose Add Images to Catalog from the File menu or click the  toolbar button.    Select the file(s) using standard 
Windows File Explorer commands. Click Open to begin the cataloging process.

· Create a new Kudo catalog  and drop thumbnails on it.

· Create a new Kudo catalog  and drop Kudo catalogs or shortcuts to catalogs on it.    If you drop the Kudo catalog on
the Kudo title bar it will open.    If you drop the catalog on the title bar of a catalog it will be added to the catalog.    
Catalogs of catalogs, also known as Index Catalogs, have interesting and useful properties.

· Drag and drop files onto the open catalog title bar and Kudo will add the files to the current active catalog.    The current 
active catalog is the uppermost catalog that is highlighted in the Kudo window.    

· Add files to a Kudo catalog  via drag and drop of images or Internet shortcuts from the Windows File Explorer, 
Microsoft Internet Explorer, Microsoft Office, Kudo Image Viewer 

 and most Windows OLE client server applications.
· Add files to a catalog by clicking on the Catalog All Open or Catalog One Image selection of the Kudo Image Viewer

 Tools menu. The equivalent toolbar button is 

.

· Add to a catalog by clicking the Catalog Selected Images from the Tools menu of Kudo Internet File Browser . 
The equivalent toolbar button is 

.
We have not encountered a limit to the number of image records in a single Kudo catalog file but there is a practical limit.    
Kudo catalogs range in size from 2 to 6 Mbytes per thousand records.    File sizes in excess of 150 Mbytes are hard to manage, 
so try to keep your catalogs less than 50,000 records. If you are managing larger file collections, it is best to create Index 
Catalogs. 



Backing Up Catalogs

Because catalogs can usually be recreated automatically by Kudo Image Browser  it is usually not necessary to back 
them up.

If your original images are not available and the catalogs are important to your work you should make copies of your catalogs 
and store them offline on removeable media such as CD-R, Zip or Jaz cartridges.    
If you put keywords or notes in your catalogs and the original images are readily available you can use a simple backup method 
for preserving your keywords and notes.    The best way to preserve your catalog’s keywords and notes is to click on the Export 
Catalog to Dbase command.    This simple tool exports the text fields from the current catalog to a CSV (Comma Separated 
Variable) or MDB data file.    Restore corrupted or lost catalogs by recreating the catalog from the original image files and 
importing the Notes field with the Import Catalog from Dbase command. 
Periodically saving the catalog text fields helps protect them against loss.    The exported CSV text files can be spell checked 
and updated with Microsoft Word.    Importing the text file back into the catalog is a convenient way to perform batch text 
operations that are not available from the Kudo Image Browser menu commands. 



Printing Your Catalog
Select Print from the Kudo Image Browser File menu to print the found set of image records in the active (uppermost) catalog. 
The existing view and found set of thumbnail image records is printed in the same resolution as seen on your screen (72dpi 
quality).    It’s best to output to a color printer.    

To print linked image files you should open them in Kudo Image Viewer  and print them.    Add captions to your 
images using the Kudo Image Viewer Write Text on Image selection from the Tools menu.    Drag and Drop Images from 
Kudo into PageMaker or Microsoft Publisher to perform professional quality page layout.



Print Preview
Opens the current found set in the Print Preview dialog.    Enables adjustment prior to printing.



Print Setup
The Print Setup command opens the printer setup dialog and gives options to select and configure available printers.



Exit
The Exit command closes all catalogs and exits the application.



Recently Used Catalogs
 The Recently Used Catalogs list displays up to 14 of the most recently used catalogs.



Edit Record Menu
The Edit Record menu includes commands to start operations that are performed on the currently selected record or the file 
linked to the currently selected record.    This menu is grayed out until a thumbnail record is selected.      

Selecting Catalog Records 

Cut Record 

Copy Thumbnail 

Copy Linked Image File 

Rename Image File 

Move Image File 

Paste 

Delete Thumbnail

Delete Image File Only

Delete Image File and Record

Delete  

Undelete Record 

Rotate Thumbnail 

Flip Thumbnail 

Notes Field Preferences 

Notes Field Preferences Dialog 

Edit Thumbnail Info 

Mark/Unmark Record 



Cut Record
Ctrl+X, or Cut from the Edit Record menu copies the selected record to the clipboard and schedules the selected record for 
deletion.    Same as Delete Record except the Cut Record command copies the record to the clipboard.    Visit Undelete Record 
and Moving and copying Records Between Catalogs for more information.



Copy Thumbnail
Copy Thumbnail copies the selected thumbnail record and the linked image file to the clipboard. The toolbar button is . 

Use Ctrl+Shift+right click on a thumbnail to copy the record to the current (selected) catalog and add a delete sign to the source 
record.    The copied record is appended to the end of the target catalog. You must have a source and a target catalog open to use 
this command.    This operation will not work if you first select the thumbnail of the record that you want to copy from. 
To replace the thumbnail image only, hold down the Ctrl+Shift keys and drag a selected thumbnail onto the title bar of another 
catalog. Select the source and target thumbnails before the drag operation and the make the current (uppermost) catalog the 
drop target.    This operation only replaces the thumbnail image in the target record.    The text data fields are untouched.    This 
is useful for making title thumbnails for Index Catalogs , movies, sounds and files that have no representative image. 

See also Moving and Copying Records between Catalogs.



Copy Linked Image File
Copy Image File selects a destination and copies the linked image file.    The original file is untouched.    

See also Moving and Copying Records between Catalogs.



Rename Image File
Renames the image file linked to the selected record and updates the Filename field.



Move Image File
Move Image File – Opens a dialog that allows you to select a new destination folder for the linked image file and updates the 
Location field of the selected thumbnail record.



Delete Record
The Delete selection in the Edit Record menu has the options of Delete Thumbnail, and Delete Record and Delete Image 
File.

Pressing the Del key, clicking on  or clicking on the Delete Record Only menu command adds a delete sign to the selected 
record.    The records are deleted when the catalog is closed. Use Undelete Record to remove the delete sign.      

Visit the Delete Found Set Records topic for more information.



Delete Image File Only
The Delete Image File Only menu command deletes the file linked to the currently selected record.    This is an irreversible 
deletion and operates on local files only.    Files should be backed up if you want to use them in the future.

Visit the Delete Found Set Image Files topic for more information.



Delete Record and Image File
The Delete Record and Image File menu command deletes the file linked to the current selected record and schedules the 
record for deletion.    Records are deleted when the catalog is closed. This is an irreversible deletion, the file and record cannot 
be undeleted.    Files should be backed up if you want to use them in the future.    

Visit the Delete Found Set Records and Files topic for more information.



Undelete Record
Pressing the Ctrl+Q keys or clicking the Undelete selection from the Edit Record menu reverses the action of the Delete 
command on the currently selected record.    The Undelete command can only be used prior to closing the catalog.



Rotate Thumbnail
The Rotate Thumbnail command rotates the selected thumbnail image 90 degrees clockwise.    The last thumbnail record 
position will be saved when the catalog is closed.    The linked image file is not affected by use of this command. This is 
especially useful for PhotoCD scans.



Flip Thumbnail
Rotates the thumbnail image in clockwise increments of 180 degrees.    This command only affects the thumbnail and not the 
linked image file.    The last thumbnail record position will be saved when the catalog is closed.



Paste
Pressing the Ctrl+V keys, clicking on  or Paste from the Edit Record menu appends the thumbnail record in the clipboard 
into the current active catalog. 

Visit the Using Copy and Paste and the Moving and copying Records Between Catalogs topics for more information.



Notes Field Preferences
Opens a dialog that selects the kind of information that is added to the Notes field during the catalog creation process. The 

settings are retained when the catalog is closed and when Kudo Image Browser  is closed.



Notes Field Preferences Dialog
A dialog for selecting the kind of information that is added to the Notes field during the catalog creation process. The settings 

are retained when the catalog is closed and when Kudo Image Browser  is closed.



Edit Thumbnail Info
Opens a dialog that allows editing text fields of the selected record.



Edit Thumbnail Dialog
Edit text fields using familiar Windows text editing commands.    Select Free Edit to prevent Kudo from verifying the 
information you enter.



Edit Found Set
The Edit Found Set menu includes commands that are performed on the found set of records or files linked to these records.    
The found set of a catalog is the list of current displayed thumbnail records.      The found set is the result of a Find operation 
and can contain all or none of the catalog records.      The number of records in the found set and the number of all records in the
catalog is displayed on the status bar. The found set is preserved when the catalog is closed and reopened.

The default found set of a newly created catalog is all the records.    Use Ctrl+A to make the found set represent all the records 
in a catalog.    Use the Find functions from the Image menu or the  

 buttons on the toolbar to create a new found set.      For example, opening the Find dialog and selecting Filename 
Contains .JPG will result in a found set of all the records linked to files with the .JPG file extension.
Edit Found Set menu commands are performed on the currently selected catalog.    Visit the topics to learn more about each of 
the Edit Found Set menu items listed below.

Copy Image Files 

Copy File Structure 

Move Image Files  

Move File Structure 

Rename Image Files 

Delete Found Set Image Files 

Delete Found Set Records 

Delete Found Set Records and Files 

Clean Found Set Records Notes Field 

Add Keyword To Found Set Notes Field 

Search and Replace Text in Found Set Notes Field 

Create Catalog from Found Set 

Verify Catalog 

View all Images in Found Set 

Get Images From URL 

Screen Saver From Found Set 

Slide Show From Found Set 

Create Slide Show List 

Change File Location Field Replace Full Path 

Change File Location Field Replace Part of Path 

Change Found Set Volume Label Field 

Refresh All Thumbnails 



Copy Image Files
The Copy Image File command copies all files linked to the current found set of records to a new folder in the local file 
system.    This command puts all the files irrespective of source path into a single target folder. The Copy Image File command 
does not update the catalog records.    



Copy File Structure
The Copy File Structure command copies all files linked to the current found set of records to a new folder in the local file 
system.    This command replicates the folder structure of the source catalog in a new target folder. The source folder and the 
target folder must have the same name. Create a target folder with the same name as the source folder before you perform this 
command. The Copy File Structure command does not update the catalog records.



Move Image Files

The Move Image Files command moves all files linked to the current found set of records to a new folder in the local file 
system. This command puts all the files irrespective of source path into a single target folder. The Move Image Files command 
updates the File Location field to reflect the new path.

The Move Image Files command is a powerful command that is intended to replace the drudgery of manually copying, 
deleting and updating a File Location found set of a single folder.      Use the Move File Structure command to move nested 
folders.



Move File Structure
The Move File Structure command moves all files linked to the current found set of records to a new folder in the local file 
system.    This command replicates the folder structure of the source catalog in a new target folder. The source folder and the 
target folder must have the same name. Create a target folder with the same name as the source folder before you perform this 
command. The Move File Structure command updates the File Location field to reflect the new path.

The Move File Structure command is a powerful command that is intended to replace the drudgery of using multiple Move 
Image Files commands to move nested folders. 



Rename Image Files
The Rename Image Files command renames the files linked to the current found set of records and updates the catalog File 
Name field.    Does not change the File Location field.    The renaming operation creates an alphanumerical sorted filename 
sequence from the found set of records. 

The renaming algorithm can take a file name prefix of up to 33 characters and add up to five numerical digits in sequence 
starting from XXX00001.YYY, XXX00002.YYY, XXX00003.YYY… where XXX is the prefix supplied from the dialog 
and .YYY is the three character file type descriptor (TIF, JPG…).    The number of digits used is determined by the number of 
files selected for the rename operation, that is, 0-9 will use one digit, 0-19 will use 2 digits…    

The total number of characters in the filename is the number of characters to the period (includes the new numerical digits and 
the filename prefix.to the left of the .YYY three character file type descriptor). The total number of alphanumeric characters in 
the filename cannot exceed 33.



Delete Found Set Image Files
The Delete Found Set of Image Files command deletes all files linked to the current found set of records.    This is an 
irreversible deletion; the files cannot be undeleted.    The files should be backed up if you want to use them in the future.    



Delete Found Set Records
The Delete Found Set of Records command schedules all the records in the current found set for deletion when the catalog is 
closed.    The records scheduled for deletion are designated with a red diagonal diameter in a circle. This is an irreversable 
deletion; the records cannot be undeleted after the catalog is closed.    Backup your catalog before you begin this operation. 

To remove the deletion designation, use the Undelete Record Ctrl+Q in the Edit Record menu.



Delete Found Set Records and Files
The Delete Found Set Records and Files command deletes all the files linked to the current found set of records and schedules
all the records in the current found set for deletion.    Records are deleted when the catalog is closed. This is an irreversable 
deletion, the files and records cannot be undeleted.    The files should be backed up if you may want to use them in the future. 

Visit the Delete Found Set Image Files and the Delete Found Set Records topics for more information.



Clean Found Set Records Notes Field
The Clean Found Set Records Notes Field command deletes all text in the Notes field of the current found set.    This is an 
irreversible deletion. Backup your catalog before you begin this operation. 



Add Keyword To Found Set Notes Field
Appends keywords to the Notes field of the current found set.    Visit the Customizing Catalogs topic for more information.



Search and Replace Text in Found Set Notes Field
Opens a search and replace dialog to find text strings and replace them in the current found set Notes field.



Create Catalog from Found Set
The Create Catalog from Found Set command opens a dialog that prompts for a new catalog name and path and copies the 
found set of records to the new catalog. This is very useful for recovering a corrupt catalog and for converting the sort order of 
the catalog to the Creation Order.      

The Create Catalog from Found Set command can make the Display Order of Thumbnail equivalent to the Physical Order 
and Creation Order of thumbnail records written on the hard disk or CD-ROM. This greatly speeds up many catalog 
operations and is similar to optimizing the files on a hard disk.



Verify Catalog
The Verify Catalog command checks the current found set of records to confirm that the linked file exists in the specified 
location field. Once the linked image file is found then Verify Catalog updates the location field of the record and proceeds to 
process the next record. Verify Catalog will not update the record if the only difference between the record and the actual 
linked image file location is the volume drive letter. If Verify Catalog can’t find the file in the specified folder it looks in the 
following locations and performs the actions in the order shown below:

· The last folder or URL that had a linked image file.

· All the currently mounted drive letter volumes with the same path but different drive letter (from A-Z). 

· If not found Verify Catalog looks in the folder where the catalog is.

· If not found Verify Catalog looks in the folder where Kudo Image Browser  is.

· If not found Verify Catalog presents a Show Me the Image File dialog or 

· If the record has a URL then Verify Catalog presents a Get Image File from URL dialog.

· If the dialog is canceled then Verify Catalog appends “ERROR: Can’t find image file” to the Notes field and proceeds 
to process the next record.

Press Esc or Spacebar or click on the catalog to stop the Verify Catalog operation.

Verify Catalog will not work on locked catalogs or catalogs set to read only.    Catalogs on CD-ROMs are read only.



View all Images in Found Set
The View Images command in the Edit Found Set menu displays all the image and multimedia files linked to the found set of 

records with the Kudo Image Viewer .    Pause the operation by clicking on the Kudo Image Viewer Pause button. 
During a pause you can close all open images.    This is useful if there are more images open than the available memory or GDI 
resources will allow. You can also pause the View All Images operation by placing the cursor on the Kudo Image Viewer title 
bar and holding the mouse button down.      



Get Images From URL
The Get Images From URL command gets all linked files in the found set of records from the Internet.    Records must have a 
URL label in the Notes field and the files cannot be present in the catalog Location field path.    If you want to update files from
the Internet it is best to rename the local directory or change the catalog Location field path before beginning this operation.

The Get Images From URL works in the background and is faster than the Verify Catalog command for downloading files 
from the Internet. 



Screen Saver From Found Set

Click the  toolbar button to create and start a screensaver of the current found set.    The Screen Saver command is also 
in the Edit Found Set menu of Kudo Image Browser.

You can also start a Kudo screen saver by clicking the  button on the Kudo Image Viewer toolbar.    The Screen Saver 
Settings command in the Tools menu of Kudo Image Viewer allows you to set the screen saver defaults. 
You can also start the Kudo screen saver from the Windows Control Panel screen saver dialog.    Select Kudo Screen Saver 
(KUDOSCR on Win95) in the Display Properties Screen Saver panel found in the Windows Control Panel. Select Kudo 
Screen Saver or “kudovs” from the Screen Saver panel dropdown menu and choose your Settings.    You can select the images 
and the background sound file.    
Kudo creates a playlist and passes it to the Screen Saver. Kudo also tells the Screen Saver to start immediately. If your mouse 
is very sensitive you will have problems starting the Screen Saver with small catalogs because it is so fast.    

The Screen Saver will display HTML files, animated GIFFs, play most popular sound and video formats. HTML files should 
have all links to local files.    

HTML files destined for distribution on CD-ROMs or the Internet should have relative file links.    This means that references to
the path of linked files should not include a drive letter or volume label.    The Internet Browser will automatically fill in the 
missing path with the current volume and directory when parsing the HTML file links. 



Slide Show From Found Set

Click the  toolbar button to create and start a slide show of the current found set.    The Slide Show command is also in 
the Edit Found Set menu of Kudo Image Browser.

 The slide show will start and play according to the current settings of the Kudo Image Viewer Slide Show Preferences.

To start a slide show from Kudo Image Viewer  select the slide show button on the Kudo Image Viewer toolbar or the 
Slide Show selection from the Tools menu. 
The slide show can also use the playlist file created by the Kudo Image Browser Tools menu Create Slide Show list command.
The Kudo slide show can play a background midi file and play WAV files that are associated with each image file.    To 
associate WAV files put them in the same directory and give them the same filename as the slide show images.

The Slide Show will display HTML files, animated GIFs, play most popular sound and video formats. If you want fast loading 
HTML pages make all links to local files.    

HTML files destined for distribution on CD-ROMs or the Internet should have relative file links.    This means that references to
the path of linked files should not include a drive letter or volume label.    The Internet Browser will automatically fill in the 
missing path with the current volume and directory when parsing the HTML file links. 



Create Slide Show List File
The Create Slide Show List File command creates a playlist file from the current found set. The playlist file is written to the 
directory that contains the source catalog.    This playlist file is used to create a slide show that can be started from the Slide 

Show From List and the Screen Saver From List commands accessed from the Tools menu of Kudo Image Viewer .   
The slide show list file cannot be larger than 32Kbytes.



Change File Location Field Replace Full Path
To use the Change File Location Field Replace Full Path command to change the drive letter of all the records in the found 
set, enter the drive letter in the dialog and press OK. 

The Change File Location Field Replace Full Path command changes the File Location field of the found set of records to a 
single new directory. This operation does not move the linked files.    You must move the linked files using the File Explorer or
with the Create Virtual CD-ROM tool. 

The Change File Location Field Replace Full Path command is intended to update the records that represent a single folder 
of images.    The command can also consolidate all image files into one folder. 

This operation destroys the link to the original files.    Backup your catalog before performing this operation on a valuable 
catalog.

Use the Move Image Files or Copy Image Files commands for batch file management tasks.



Change File Location Field Replace Part of Path
The Replace Part of Path command changes the file location field of all records that contain the selected folder and all nested 
folders.    The Replace Part of Path command performs a search and replace operation on the file Location field. This greatly 
simplifies updating a catalog after using the Copy File Structure command to copy portions of an image catalog’s structure. 

The Change File Location Field Replace Part of Path command moves a folder of images and its nested folders to any other 
folder.    This command can be used to move a directory tree within a volume or between volumes.    

The Change File Location Field Replace Part of Path command moves the original image files and updates the location 
fields in the catalog.

This command is very powerful and should be used cautiously. Backup your catalog before performing this operation on a 
valuable catalog.

Use the Move Image Files or Copy Image Files commands for batch file management tasks.



Change Found Set Volume Label Field
The Change Found Set Volume Label Field command changes the Volume Label field of the current found set of records.    
The Volume label field is used to create a meaningful error message when Kudo tries to access a CD-ROM or network volume 
that is not mounted.

To create the following error message:

“Please insert CD-ROM label: 

VOLUME_LABL 

When CD is ready press OK” 

append the text string “CD_LABEL: VOLUME_LABL” to the Notes field of an Index Catalog.    The VOLUME_LABL 
string is the Volume label field.



Refresh All Thumbnails
The Refresh All Thumbnails command updates the thumbnail images of the current found set of records.    This Edit Found 
Set menu command creates a new thumbnail from the linked file and updates the File Size and File Modification Date only.    
The linked image files must be available for this operation to succeed. This command was designed to improve the appearance 
of thumbnails that were exported from the Mac. 



View Menu
The View menu commands listed below allow you to select various different views of the information in a Kudo catalog and 
different views of the Kudo Image Browser main window.    Visit the topics for more information.

Small Gallery View 

Gallery View 
List View 

Tree View 

Toolbar 
Status Bar 
Forward Riffle      
Backward Riffle 



Small Gallery View
To change the current catalog view to Small Gallery View press Ctrl+S, click the  toolbar button or select Small Gallery 
View from the Kudo Image Browser View menu.    The Small Gallery View uses a grid style layout like Gallery View and 
displays a 60 by 60 pixel thumbnail image.



Gallery View

Kudo catalogs open in Gallery View.    To change to Gallery View press Ctrl+G, click the  toolbar button or select 
Gallery View from the Kudo Image Browser View menu.    The Gallery View uses a rectangular grid layout for displaying 
records with thumbnail image, file name, file size and extension.    The thumbnails are 120 by 120 pixel. 

Click the  toolbar button to get information about the file linked to the selected thumbnail record.



List View

To change the current catalog view to List View press Ctrl+L, click the  toolbar button or select List View from the 
Kudo Image Browser View menu 

The List View shows the thumbnail records in a vertical column accompanied by the Notes field.    You can edit these notes and 
other text fields by clicking a thumbnail with a single left mouse click and selecting Edit Thumbnail Info from the Edit Record 
menu.    Add, delete or change text with the keyboard edit keys. 



Tree View Dialog
Kudo Tree View displays the volumes, folders and files in the catalog.    This view of the catalog is similar to the File Explorer 
detail view.      The Tree View simplifies catalog navigation and complements the other three catalog views. 

To open the Tree View window, press Ctrl+T, click on the  toolbar button or select Tree View from the Kudo Image 
Browser View menu.

Double clicking on a folder in the Tree View window with the left mouse button displays the files in the folder. Double clicking 
on a file with the left mouse button finds and selects the record in the Kudo Image Browser catalog window.    
Select files in the right side of the Tree View window using the standard File Explorer selection commands.    Ctrl left click 
selects a file.    Shift left click selects a range of files.    

Right clicking on a file or a selected set of files displays a useful subset of the Kudo Image Browser menu commands.    

Selecting Tree View the first time creates an MDB file of the catalog text fields.    You should have Microsoft DAO (Data 
Access Object) files installed on your computer to speed up some of the Tree View operations.    Download and run the free 
Microsoft DAO installer from http://imspace.com/downsupp.htm.



Tree View Menu
Kudo Tree View displays the volumes, folders and files in the catalog.    This view of the catalog is similar to the File Explorer 
detail view.      The Tree View simplifies catalog navigation and complements the other three catalog views. 

To open the Tree View window, press Ctrl+T, click on the  toolbar button or select Tree View from the Kudo Image 
Browser View menu.

Double clicking on a folder in the Tree View window with the left mouse button displays the files in the folder. Double clicking 
on a file with the left mouse button finds and selects the record in the Kudo Image Browser catalog window.    
Select files in the right side of the Tree View window using the standard File Explorer selection commands.    Ctrl left click 
selects a file.    Shift left click selects a range of files.    

Right clicking on a file or a set of files displays and allows selection of a useful subset of the Kudo Image Browser menu 
commands.    

Selecting Tree View the first time creates an MDB file of the catalog text fields.    You should have Microsoft DAO (Data 
Access Object) files installed on your computer to speed up some of the Tree View operations.    Download and run the free 
Microsoft DAO installer from http://imspace.com/downsupp.htm .



Toolbar
The Tool Bar menu selection allows you to toggle between showing and not showing the toolbar.



Status Bar
The Status Bar menu command toggles the status bar.    The status bar shows the state that Kudo is in as well as the number of 
records in the current found set and the total number of records in the current (selected) catalog.    

For example, the current catalog contains 100 records.    After executing a Find  Ctrl+F operation, 35 thumbnail records 
met the search criteria.    The catalog will now display a found set of 35 records and the status bar will display 35 of 100 found.

To restore the catalog to the full 100 displayable thumbnails, press the Ctrl+A keys, click the  toolbar button or the Find 
All command from the Image menu.



Forward Riffle Feature
The Riffle feature allows you to visually browse the thumbnail records, as you would thumb the pages of a book.    The 
thumbnail images appear one at a time in the lower right corner of the main window. 

Select the  or 

 buttons in the tool bar to initiate the Riffle process.      Control the speed with the up and down cursor keys.
Kudo will advance through the catalog until you press the space bar, escape key, enter key or until it reaches either end of the 
catalog.
Kudo stops near the record that you choose and displays the surrounding records.    Your reactions may be slower than Kudo’s 
Riffle feature, so when you release the Riffle control, you may have selected a record that is a few frames ahead of the one you 
wanted.    



Backwards Riffle 
The Riffle feature allows you to visually browse the thumbnail records, as you would thumb the pages of a book.    The 
thumbnail images appear one at a time in the lower right corner of the main window. 

Select the  or 

 buttons in the tool bar to initiate the Riffle process.      Control the speed with the up and down cursor keys.
Kudo will advance through the catalog until you press the space bar, escape key, enter key or until it reaches either end of the 
catalog.
Kudo stops near the record that you choose and displays the surrounding records.    Your reactions may be slower than Kudo’s 
Riffle feature, so when you release the Riffle control, you may have selected a record that is a few frames ahead of the one you 
wanted.    



Image Menu
The Image menu commands allow you to display the file linked to the selected record and see the file properties.    The Find

 and Find All 

 commands are also available on the toolbar.
View File 

Properties 

Find 

Find All 



View File

To view a file linked to a thumbnail record, open a catalog in Kudo Image Browser , select a thumbnail and right click 
it.    The Kudo Image Viewer 

 will open and display an image file, play a media file, open an Internet shortcut or URL. 
Select a Kudo thumbnail image record with a single left mouse click. The record is properly selected when it is highlighted.
The thumbnail images in the Kudo catalog are linked to files on the local or remote file systems.    The Kudo Image Viewer

 requires the linked file to be local.      Right click on the selected thumbnail image to copy the file from a remote file 
system.    The Kudo Internet File Browser 

 will copy the file to the path in the Location field of the record.

If the Kudo Image Viewer  is not available, the built in Kudo viewer will display the image file.    This feature is also 
available from the Image menu by selecting Viewer.    Press Ctrl+E or click the 

 toolbar button to view the selected image file.

Kudo Image Viewer  will display image and play media files described in the the KUDOVW32.INI file.    Kudo supports
direct play of MPEG, AVI, WAV, MOV and GIF animation files.
Kudo cannot display or play files stored on volumes that are not mounted on your system (i.e. floppy disks, CD-ROMs, 
removable cartridges, etc.).    Kudo will identify the correct volume and ask you to mount it if the selected file cannot be found 
on your system.    Kudo will also get the file from an available URL.



Properties 
The Properties command displays the text information associated with the linked image file.      This information includes file 
name, size, modification date, volume, location, and any notes, captions, URL or keywords you have attached to the record.

To display a record’s properties:

1. Select a record with a single left click of the mouse to a thumbnail image.

2. Select Properties from the Image menu    or click the  button)

3. Kudo will display the information in a floating window. 

When the Properties window is open, click other records to quickly display their properties.



Find
Use the Kudo Image Browser Find command to help find records in Kudo catalogs.      The records contain textual and image 
information to help you more easily identify the linked files. The links to the original files are in the file Location field and in 
the file Name field.    URL links to the original file are stored in the Notes field.    

It is impossible to uniquely describe a natural image with only textual or symbolic descriptors.    Kudo Find operations are 
therefore intended to create found sets of records that can be further visually browsed by the user to identify images of interest.  

To begin a find operation, press Ctrl+F, click Find from the Image menu or click the  toolbar button. The Find and 
show image whose dialog box will appear.

Create a search using the drop down lists in the Find and show image whose dialog box. Click the Find button to search the 
catalog and display the found set of records.    The number of records in the found set is displayed in the catalog status bar.
The default search will include all records in the current (uppermost) catalog.    Click the Search on found set box to limit the 
search to the current found set of records.    Click the Search all open catalogs to extend the search to all catalogs in the Kudo 
Image Browser window. 
Click the Options box in the Find dialog to create a search using up to three search criteria.    This search uses the logical AND 
operator.    Each record in your found set must match all your search criteria.    Kudo does not support the logical OR operator.    

If necessary, you can perform an OR search from a sequence of found sets.    The object is to create a catalog which is a 
compilation (Notes Contains black OR white OR yellow) of found sets.    Use the Create Catalog From Found Set command on
each search result and the Merge Catalogs command to create the desired found set.

The Find operation is not letter case sensitive and will display all instances of a search string; wildcards are not required.

Add a drop down list for selecting Keywords and File Locations by creating a CATALOG.INF file. .    

Keywords are added to the Notes field.    File Location is a separate field containing the path to the image file.

The Notes Field Preferences controls the automatic annotation of image file information into the Notes field during the catalog 
creation process.    This is very useful for capturing textual descriptors that are stored in the image file and the image file path or
URL.    Images stored in folders that have meaningful category names can use this folder name as a keyword.    IPTC or 
PhotoShop file annotations can also contain useful image descriptors.

The Range of Records search operator requires you to add the beginning record number and ending record number of a 
contiguous range of records with a – between the record numbers.    The record numbers are obtained by selecting the thumbnail
and reading the record number from the Kudo Image Browser status bar (as Thumbnail # XX).



Find Dialog
Select the search parameters from the drop-down selection lists and click on Find.    Click on Options to create a more complex
search.



Find Dialog Options
Select the search parameters from the drop-down selection lists and click on Find. 



Find All
Find All searches for and displays all records in the active catalog.    This feature is also used to re-display all records after a 

Find operation.    Find All can also be invoked via Ctrl+A or on the toolbar..



Sort Menu
The sort menu works on the found set of records displayed in the current (uppermost) catalog of the Kudo Image Browser 
window.    Kudo uses an alphabetical sort on text fields and a numerical sort on date and size fields.    Sorting to create a display 
order is useful for using and viewing catalogs.

File Name Sorts records by the file name

File Size Sorts records by the size of the original disk file

File Kind Sorts records by the file type (extension)

File Modification Date Sorts records by the date the file was last modified

File Location Sorts records by the file location pathname

Notes Sorts records by the characters in the Notes field

Record Creation Order Sorts records by the order they were added to the catalog

Record Physical Order Sorts records by the order they are physically stored on disk

Sorting 
The display order of thumbnail image records is also the sort order of a Kudo catalog.    The sort order is preserved when a 
catalog is closed.

The sort order created by the Sort menu options file Name, file Size, file Kind, file Modification Date, file Location and 
Notes are a logical ordering of the records. The sort order created by adding records to the catalog is called the Creation order.  
The Physical order is the order that the catalog thumbnail image records are stored on disk.    The Creation order and the 
Physical order are identical in a newly created catalog.    After record deletions, merge and compaction operations the Creation 
order and the Physical order differ. 

The sort feature works on the current found set. To sort the found set of the current (uppermost) catalog select a sort option 
from the Sort menu. Kudo will automatically re-arrange the thumbnail image record display to reflect the new sort.



Sort by Filename
Sorts the current found set of records Filename field by alphabetical order.    This sort order is retained when the catalog is 
closed.



Sort by File Size
Sorts the current found set records File Size field by numerical order.    This sort order is retained when the catalog is closed. 



Sort by File Kind
Sorts the current found set records File Kind field by alphabetical order.    This sort order is retained when the catalog is closed.



Sort by File Modification Date
Sorts the current found set records File Modification Date field by numerical order.    This sort order is retained when the 
catalog is closed.



Sort by File Location
Sorts the current found set records File Location field by alphabetical order.    This sort order is retained when the catalog is 
closed.    



Sort by Notes
Sorts the current found set records File Notes field by alphabetical order.    This sort order is retained when the catalog is closed.



Sort by Record Creation Order
Sorts the current found set records Record Number field by numerical order.    This sort order is retained when the catalog is 
closed.    This sort is important for catalog import/export operations.



Sort by Record Physical Order
Sorts the current found set records Record Disk Pointers by numerical order.    This sort order is retained when the catalog is 
closed.    This sort is important for speeding up catalog browsing and viewing operations.



Save Thumbnail as BMP
This option under the Tools menu is a quick method of converting the catalog thumbnail to a BMP file of 120 by 120 pixels in 
8-bit color. This feature uses the thumbnail image in Kudo not the original image file.    To convert the original image file to 

BMP format choose Save Image in BMP Format from the Tool menu of Kudo Image Viewer .



Tools Menu
Visit the topics listed below to get information about the Tools menu commands.

HTML Export 

HTML Export Dialog 

Custom HTML Templates 

Make Icon of Thumbnail 

Save Thumbnail as BMP

Selected Image As Wallpaper 

Reveal Image's Folder 

Merge Catalogs 

Find Duplicate Images 

Export Catalog To Dbase 

Export Catalog to MDB 

Import Catalog From Dbase 

Import Catalog from MDB 

Export Catalog to Macintosh 

Import Macintosh Catalog 



HTML Export
Click on the Tools menu, select Create HTML Page and follow the prompts to instantly create an HTML version of the current
found set.    You can publish any kind of media or document file.    We recommend JPG format for thumbnails and screen size 
images and AVI, MOV, MID and WAV formats for video and sound files.

The current found set of thumbnail image records is used as source images for the HTML page. Kudo uses the internal 
thumbnail image to make GIF or PNG format image files to represent the image or media files you have chosen to publish on 
the Internet.    Kudo uses the original image file to make JPG thumbnail images. 

To export the current found set to HTML, fill out the HTML File Creation Tool dialog box.    

· Enter text for the heading of the page and for the body text. You can also input the URL or Internet address of your home 
page to be displayed just below the body text. 

· Designate a source folder for Kudo to store your new HTML files 

· Select one of the four different page-layout options

· Select the format you would like for the thumbnail images: JPG (Low, Medium and High quality), GIF (an 8-bit format) or
PNG (up to 48bit).

· Select the format of your original image, media or document files.

· Click ‘OK’ 

Kudo automatically writes as many HTML pages as needed to publish your current catalog selection of image, media and 
document files on a Web site. and places them in the designated folder.    

Kudo will create thumbnails of your original images and place them in a folder called ‘THUMBS’.    Copy the original image 
and media files to the folder called ‘IMAGES’. 

Test your new HTML pages with your Internet browser before deploying to your Web server.    If you have lots of pages you 
can test them automatically by making a catalog of the HTML pages and clicking on the slide show button.

The image tags in your HTML pages use relative paths, so retain the same relative directory structure when you upload the files
to the Web server.    Don’t change the names or relative arrangement of the folders.

Use Kudo Internet File Browser , the cool new Kudo FTP/HTTP client, to copy your new HTML pages and files to 
your Web server.     Kudo Internet File Browser 

 provides a Windows File Explorer copycat interface that seamlessly integrates the local and remote file system.  Kudo 
Internet File Browser 

 uses familiar Windows File Explorer commands to perform file operations on your remote Unix or NT Web server.
More advanced Web weavers may wish to edit the custom HTML template file, adding custom elements like background 
graphics, colors, or text formatting. This is not necessary, however, as Kudo will create standard files that are ready to upload to
any Web server.

For a complete description of creating and using Kudo custom HTML page templates see the file “CUSTOM.TXT” in the Kudo
program directory or visit http://www.kudo.com/samples.htm.



Export HTML Dialog
Select the options and click Start. HTML Export



Custom HTML Templates
Select the options and click Start. HTML Export



Make Icon of Thumbnail
Creates a Windows icon of any thumbnail image in your catalog.    Kudo will create an image file with the ’.ICO' extension, 
suitable for use as a file, folder or volume Windows icon.    This feature uses the thumbnail image in Kudo not the original 
image file.    To use the original image as the icon source file you should choose Make Icon of Image from the Tool menu of 

Kudo Image Viewer .



Selected Image As Wallpaper
Selected Image As Wallpaper – Adds the selected BMP image to the Windows desktop.    If the image is not BMP you should 

choose the Selected Image As Wallpaper selection from the Tools menu of the Kudo Image Viewer .



Reveal Image's Folder
Reveal Images Folder – Opens the folder location where the linked file resides.    



Merge Catalogs
Merge Catalogs – Appends a smaller to a larger catalog.    Checks for duplicate paths.



Find Duplicate Images
Find Duplicate Images - Creates a text file listing all filenames that are duplicated (have N-1 instances) in the catalog.    
Duplicates have one entry whereas triplicates have 2 and quadruplicates have 3 entries in the text file listing.    The filenames 
are listed in the order encountered in the catalog (sorted by Creation Order).    These are filenames and not paths.    Kudo 
catalogs accept duplicate filenames but not duplicate paths.



Export Catalog to Dbase
Export the text data fields from a Kudo catalog to a comma delimited TXT file. 



Export Catalog to MDB
Export the text data fields from a Kudo catalog to an Access MDB file.



Import Catalog from Dbase
Import the text data fields from a Kudo catalog to a comma delimited TXT file or to a Microsoft Access MDB file. The import 
file must have the identical record structure as a file created by the Export Catalog to Dbase function.    The best way to do 
this is to create and edit an export file from the target catalog.    

You can import text fields from a database that does not have the same record structure as the target catalog by editing the 
import file so that it has the same structure.      

The Kudo catalog Notes field is the only variable field and can hold up to 1024 characters.    Concatenate all the extra fields 
from your database file into single field and import the new database into the target Kudo catalog.

Export selected fields, with the Filename field, from the database to an MDB file.    Open the database MDB file and the Kudo 
export MDB file in Microsoft Access.    Concatenate and format the database fields into a new field called Notes.    Merge the 
new Notes field into the Kudo export MDB file.    Import this merged file into the Kudo catalog.    

The reason for merging the database file with the Kudo export file is to add the Kudo catalog record number index to the import
file.    This greatly speeds up the operation.

The Import Catalog from Dbase Tool will also import a two-field MDB data file (Filename and the Notes field only).    Don’t
forget that import Filename data can be letter case insensitive but has to be an exact character for character match.    This 
operation is slower because it doesn’t have the benefit of the Kudo catalog record number.



Import Catalog from MDB
Import the text data fields from a Kudo catalog to a comma delimited TXT file or to a Microsoft Access MDB file. The import 
file must have the identical record structure as a file created by the Export Catalog to Dbase function.    The best way to do 
this is to create and edit an export file from the target catalog.    

You can import text fields from a database that does not have the same record structure as the target catalog by editing the 
import file so that it has the same structure.      

The Kudo catalog Notes field is the only variable field and can hold up to 1024 characters.    Concatenate all the extra fields 
from your database file into single field and import the new database into the target Kudo catalog.

Export selected fields, with the Filename field, from the database to an MDB file.    Open the database MDB file and the Kudo 
export MDB file in Microsoft Access.    Concatenate and format the database fields into a new field called Notes.    Merge the 
new Notes field into the Kudo export MDB file.    Import this merged file into the Kudo catalog.    

The reason for merging the database file with the Kudo export file is to add the Kudo catalog record number index to the import
file.    This greatly speeds up the operation.

The Import Catalog from Dbase Tool will also import a two-field MDB data file (Filename and the Notes field only).    Don’t
forget that import Filename data is letter case insensitive but has to be an exact character for character match.    This operation 
is slower because it doesn’t have the benefit of the Kudo catalog record number.



Export Catalog to Macintosh
Create a catalog on Win95/NT4 with Kudo v5 and export it to Mac with the Windows to Mac Export tool found in the Tools 
menu of Kudo Image Browser. Here’s how:

· From your Macintosh, create a one record Kudo catalog with Kudo Image Cataloger or Kudo Image Browser on 
your shared Mac drive.    This one record Mac catalog will be the template and will be filled with records from the 
Windows catalog.    The template catalog must be shared with the Windows machine.

· From your Windows machine, open the Windows catalog that you want to export to Mac.    

· From your Windows machine, select Windows to Mac Export from the Tools menu and follow the prompts. 

· If you cannot see the Mac template catalog during the Select the MACINTOSH catalog to use as a template dialog,
refresh the window with the F5 or change the file name to *.*.    Enter a name for the Macintosh volume to replace 
the Windows drive letter or the target volume label will be chosen.

· From your Mac, open the new catalog while holding down the Option key.

· From your Mac, press the Cmd+A keys to display all the images in the catalog. 

· From your Mac, with the new catalog open, drop the folders containing the image files on the Kudo Image Cataloger 
or Kudo Image Browser icon. This improves the look of your catalog thumbnails by updating the color palette of your
new catalog to Macintosh. 

· All text and image fields except the Creator are exported to the Macintosh catalog.    Use the Set Creator Given 
Type script in the Kudo Image Cataloger for Macintosh Scripts menu to add a creator code.

Kudo must be able to write to a Mac file system from a Windows file system to be able to export the Windows catalog file to a 
Mac.    There are only two ways that we know of to do this:

· Share files between Mac and Windows with SoftWindows 98 (or Virtual PC) on your PowerMac.      

· Share files between Mac and Windows computers with a Windows NT or Novell file server.



Import Macintosh Catalog
Opens a Macintosh Kudo catalog and converts it to a new style (KDN) Windows catalog.    In order for the converted Mac 
catalog to work on Windows the file names in the Mac catalog must have a valid Windows name.    The Create Virtual CD-
ROM topic has a good discussion of cross platform file names.

The Mac to Windows Import command is the only way to import a long file name catalog from the Macintosh to Windows 
95/NT4.

Improve the look of your new Windows catalog by converting the color palette with the Refresh all Thumbnails command 
from the Edit Found Set menu.



CD Publisher
This menu provides access to the special tools used for making Kudo CD-ROMs and publishing catalogs.    This menu is only 
available to Kudo Image Publisher licensees.

Lock Catalog 

Unlock Catalog 

SlideShow List For Start32 

SlideShow List for Start32 Dialog 

Create Virtual CD-ROM 

Create Virtual CD-ROM Dialog 

Select Virtual CD-ROM Drive Letter 



Lock Catalog
The Lock Catalog command locks the catalog to prevent alteration. This lock can only be unlocked by the Unlock Catalog 
command.    This lock is not the same as the Read Only file attribute. This is useful when distributing catalogs on CD-ROMs 
and the Internet. 



Unlock Catalog
Unlocks a locked catalog. 



SlideShow List For Start32
The SlideShow List for Start32 command opens the Create SlideShow List for Start32 Dialog. Select the SlideShow List for 
Start32 command from the Kudo Image Browser CD-Publisher menu.

The Create SlideShow List for Start32 Dialog creates playlist files from the current catalog.    The playlist files are named 
SLIDESHW.LST or SCRNSVR.LST and should be stored in the \Win_kudo folder of the virtual CD-ROM. The slideshow list 
file cannot be larger than 32 Kbytes.

Start the Slideshow and Screensaver with the buttons on the Kudo CD-ROM Startup Screen. The Slideshow and 
Screensaver can also be configured to automatically start when the CD-ROM is inserted.

The Slideshow, Screensaver and Open Catalog buttons on the Kudo CD-ROM Startup Screen are enabled when you select 
the SlideShow Support option in the Create Virtual CD-ROM Dialog and have a SLIDESHW.LST and SCRNSVR.LST file in 
the \Win_kudo folder of the virtual CD-ROM . 

The virtual CD-ROM that is built with the SlideShow Support option has Kudo Internet Multimedia Suite Catalog Reader 
installed in the \Win_kudo\Program directory.

To run the slideshow and screensaver without installing Kudo on the hard disk, the Kudo CD-ROM needs:

1. The image and media files on the CD-ROM. 

2. The SLIDESHW.LST or SCRNSVR.LST playlist files in the \Win_kudo folder of the CD-ROM.    

3. The full \Win_kudo\Program directory. 

4. The Start32.exe and Autorun.inf files in the root of the CD-ROM.

Modify the \Win_kudo\Program\KUDOVW50.INI file to change the behavior of the slide show created with the \Win_kudo\
SLIDESHW.LST playlist file.    This slide show has the behavior options of the Kudo Image Viewer slide show.

Modify the \AUTORUN.INF file in the root of the virtual CD-ROM to change the behavior of the screensaver created with the \
Win_kudo\ SCRNSVR.LST file.    This screensaver has the behavior options of the Kudo Screen Saver (KUDOVS.SCR).

The main differences between the Screensaver and Slide Show are:

· Slide shows can be set to manual scrolling which makes it useful for self paced presentations. 

· Slide shows can play a sound (WAV) file when displaying an image file.    The WAV file must have the same filename 
and be in the same directory as the image file.    

· Screensavers load faster and exit with any mouse or keyboard action.

· Both screensavers and slideshows can play a background MIDI file. 

The index catalog in the \Win_kudo directory will open when the slide show is exited.    If no index catalog is present the first 
catalog will be selected.

Please refer to the Kudo Image Publisher Developer’s Guide for more complete information. 



Create SlideShow List for Start32 Dialog
To understand this dialog go to SlideShow List For Start32 .



Create Virtual CD-ROM
The Create Virtual CD-ROM command in the CD Publisher menu opens the Create Virtual CD-ROM Dialog that allows you
to specify the parameters that Kudo needs to automatically create a CD-ROM on a Windows 95/98/NT4 hard disk.    You can 
also create a Macintosh CD-ROM,    if your workstation can see a file server volume that has Macintosh file support. This 
selection is only available to Kudo Image Publisher licensees.

Most problems encountered when burning CD-ROMs are caused by the restrictive CD-ROM filing systems.    The file naming 
convention and the allowed nesting of directories is more restrictive for CD-ROMs than for Windows 95/NT4, Macintosh and 
Windows 3.1 native file systems.

We assume you will be writing single session CD-ROMs with the Joliet extension to ISO9660, Macintosh HFS or hybrid 
HFS/ISO9660 format file systems.    We recommend using a Power Macintosh system with Adaptec Toast for burning all CD-
ROM formats or a Windows 95 system with Adaptec Easy-CD Pro to burn Windows CD-ROMs. 

The Joliet extension to ISO9660 allows 12 character (8.3) MS-DOS filenames and 31 character (27.3) Win95/NT4 filenames.    
Spaces are allowed but */:;?\ are illegal filename characters.    No more than 8 levels of directory nesting are allowed.    We 
recommend no more than 1,000 files per sub-directory.

Macintosh HFS allows 31 character filenames.    A cross platform Mac/Win CD-ROM that supports Windows 3.1 users must 
use MS-DOS 8.3 filenames for all shared content files.    A cross platform Mac/Win CD-ROM that does not support Windows 
3.1 users can use 31 (27.3) character filenames for all shared content files.

To create Mac/Windows hybrid CD-ROMs you must have:

· a local area network volume that supports Macintosh files.    Imspace Systems uses Novell and Windows NT servers to 
create cross platform virtual CD-ROMs or

· a Power Macintosh running Virtual PC or SoftWindows95.    The Mac should also have the CD-R burner installed.

The virtual CD-ROM should behave as the actual CD-ROM and is useful for testing because it allows you to identify and fix 
problems quickly.    CD-R blanks are cheap but it is much faster to test the virtual CD-ROM before burning.

The CD-ROM tutorial in the Kudo Image Publisher Developer’s Guide takes no more than 20 minutes and gives you an 
understanding for the overall process before you begin a project.      



Create Virtual CD-ROM Dialog
Use the Create Virtual CD-ROM Dialog to create a virtual CD-ROM that has the image files and executables necessary to 
behave like an actual CD-ROM.    The structure of the virtual CD-ROM includes a \Win_kudo folder, a \Content folder and files
on the root.    The Kudo v5 demo CD-ROM is an example of this structure.

To create your virtual CD-ROM:

1. In the Select Virtual CD-ROM Drive Letter box enter the root folder of a hard disk or network volume as the destination 
drive for your virtual CD-ROM and click on Open. 

2. Enter the CD-ROM volume label.    The default volume label is the same as the virtual CD-ROM destination drive.    Use 
up to 11 uppercase characters with no spaces.    Create a meaningful label that uniquely identifies the CD-ROM volume.   
The volume label is required for Macintosh CD-ROMs and is used by Kudo in error message, such as “Please mount 
volume XYZ”.

3. Add the catalog(s) and select from the five CD-ROM options in the upper right corner of the Create Virtual CD-ROM 
Dialog.    If you don’t select Windows 3.1 support or Win/Mac Hybrid CD-ROM you will get a virtual CD-ROM built
for the Windows 95/98/NT4 user. Selecting Windows 3.1 support significantly limits your CD-ROM’s features.

4. Select SlideShow Support if you want to include SlideShow, Screensaver and Open Catalog buttons on the Kudo CD-
ROM startup screen. A description of Kudo CD-ROM slide show support is in the SlideShow List For Start32 topic. 

5. Click the Build button. On a fast machine the process of copying 650 Mbytes of files to the virtual CD-ROM should take
no more than 10 minutes.    It’s slower over a network.

6. Install the Catalog Reader on the target workstations.    Run a slide show and screen saver.    Test the Kudo functions that
are important to you and your users. Kudo automatically changes the catalog file attribute to Read Only.    This protects 
the catalogs from accidental changes during the testing process. 

7. Burn a one off CD-ROM using the virtual CD-ROM as the source. Copy the virtual CD-ROM to your Mac or Windows 
local drive before burning the CD-ROM. We assume you will be using Adaptec Toast 3.5 on a Macintosh or Easy CD 
Creator on a Windows 95 machine. If you are creating lots of CD-ROMs we recommend buying a Macintosh just to use 
Toast because it will save you lots of headaches.

During the build process the Create Virtual CD-ROM tool copies the catalogs to \Win_kudo, updates the catalogs File 
Location field, copies the image files to \Content\Catalog\ and pauses.    The pause lets you stop the process before the Kudo 
installer, startup and slideshow support files are copied. 

The Create Virtual CD-ROM tool will also copy all customizing files that are in the same directory as the source catalogs, that
is, the CATALOG.INF, CATALOG.BMP, CATALOG.WAVE, CATALOG.AVI and the equivalent SPLASH.XXX files.    These 
files are included in the CD-ROM file space calculations.

You can run the Create Virtual CD-ROM tool as many times as you want.    Each time it copies over existing files of the same 
path and doesn’t delete any files.    So you can always add a catalog at a time until you are satisfied with the result. Select the 
Catalogs Only (NO CONTENT) box to prevent Kudo from copying the original image or media files to the CONTENT 
directory of your virtual CD-ROM.

You can prevent errors during the build process if you verify your catalogs beforehand.    The Verify Catalog tool is in the Edit 

Found Set menu of Kudo Image Browser .

A tutorial and more detailed instructions for making virtual CD-ROMs on Mac and Windows platforms are provided in the 
Kudo Image Publisher Developer’s Guide.

Links to resources for CD-ROM duplication, labeling, CD-R supplies and CD organizations are available in the Related Sites 
section of www.kudo.com.



Select Virtual CD-ROM Drive Letter
Select the root folder of an uncluttered hard disk or network volume as the destination drive for your virtual CD-ROM and click
on Open.    

If you don’t have a free local or network drive to select as the destination drive, use the SUBST command to make a virtual 
drive.    Win95/NT4 allows you to map any local directory to a drive letter via the SUBST command.    To make a virtual drive 
Z: on your local drive D:/Kudovirtualcd folder go to the MS-DOS command prompt and enter SUBST Z: D:/Kudovirtualcd.   
For information about the SUBST command type SUBST /? at the command prompt.    An additional Z: drive will appear in the
File Explorer.    Give this drive the same Volume label as your CD-ROM, set it to Read Only (after you have created the Kudo
virtual CD-ROM) and it should behave just like the CD-ROM.    

Local Windows 95/NT4 hard disks cannot support Macintosh files.



Window Menu
Arrange Icons 

Close all 

The window menu also displays a selection list of all open catalogs.



Arrange Icons
Arrange Icons - Organizes all minimized catalogs in the Kudo Image Browser window



Close all
Close all - Closes all open catalogs in the Kudo Image Browser window



Help Menu
Help Index    - Launches the Kudo Image Browser Help file

Help On KIMS    - Launches Kudo Internet Multimedia Suite Help file

Using Help - Launches the Windows Help file

Kudo Mouse Commands – important Kudo commands that use the mouse

Open Kudo Unlock – Opens the Kudo unlock dialog.    Used to enter the unlock code to convert the evaluation version to full 
registered version.    The unlock code will only work on the machine that was used to generate the Unlock Request Key.

Open Buy Kudo Dialog – Opens the Buy Kudo Form that allows you to purchase an unlock code.    This form also generates 
an Unlock Request Key that is a fingerprint of your computer.    The unlock code created from the information in the Buy 
Kudo Form can be used to convert the evaluation version of Kudo to the full registered version. 

Open Kudo Web Page

Open Catalog Publisher’s Web Page

Open Kudo Image Viewer

Open Kudo Internet File Browser

About Kudo

Splash Screen



Help Topics
Opens Kudo Image Browser Help file



Help on KIMS
Opens Kudo Internet Multimedia Suite Help file or Kudo Image Publisher Help file



Using Help
Opens Microsoft Help on Help



Kudo Mouse Commands
Right click on thumbnail display image

Double left on thumbnail open image in associated application

Left click on thumbnail selects thumbnail for further processing

Alt+left click on tnail toggles mark/unmark a record

Shift+left click on two tnails toggles mark/unmark a set of records

Ctrl+drag thumbnail insert linked image file in MS Office apps

Drag & drop thumbnail insert linked image file into OLE apps

Drag & drop thumbnail on 
catalog

refreshes record

Drag & drop thumbnail on KIB
titlebar

refreshes record if linked file is modified

Ctrl+right click on thumbnail copy record to the current (selected) catalog

Ctrl+Shift+right click on 
thumbnail

copy record to catalog & delete source 
record.

Shift+right click on thumbnail open Get Image From URL dialog

Ctrl+Shift drag & drop 
thumbnail

replace the target thumbnail image only

Kudo mouse commands speed your work. To use Kudo Image Browser’s set of mouse commands you need to understand 
Windows drag and drop.    Some Kudo mouse commands use the Ctrl and/or Shift key combined with a click and drag 
movement of the mouse during the operation.    Press down the Shift and/or Ctrl key at the start of the operation and hold the 
key down until the mouse button is released.    

1. Right click on thumbnail to display or play linked file in Kudo Image Viewer . If the linked file is not on your 
local system Kudo Image Browser 

 will open the Get Image From URL dialog to give you an opportunity to get the file from the Internet.    
2. Double left click on thumbnail to open original image in associated application.      Set associated application by right 

clicking on original image file from the File Explorer and choosing Open With.    If the linked file is not on local system 
and there is a URL in the Kudo record it will open in the Internet Explorer or Netscape Navigator.

3. Left click on thumbnail to select the record or its linked file for further processing with the Edit Record menu commands. 
Some mouse commands only work on the selected record.    The “copy record to current catalog” command will not 
work if you select the source record with a left click.

4. Alt+left click marks and unmarks a record.    Unlike the File Explorer, Kudo Image Browser catalog marks are retained 
after a catalog open and close operation.    To remove marks you must unmark them.    

5. Shift+left click on two records marks and unmarks all records between the clicks.    The first click selects the first record 
but doesn’t mark until until you have completed the second click.    The cursor changes to a checkmark until the second 
click is completed.    Unlike the File Explorer, Kudo Image Browser catalog marks are retained after a catalog open and 
close operation.    To remove marks you must unmark them. To remove all marks use Find to find all marks and shift+left 
click on the first and last record of the found set of marked records.    If necessary, use the Home and End keys to go to the
beginning and end of the found set of marked records.    

6. Ctrl+drag selected thumbnail and drop it into an open Microsoft Office document window to insert linked image or media 



file.    

7. Drag selected thumbnail and drop into an open document window to insert or open the linked image or media file.    Some 
application documents are not well-behaved OLE drop targets and require you to drop onto the title bar, use Ctrl+drag or 
copy and paste. 

8. Dragging thumbnail to title bar of Kudo Image Browser  will refresh record if linked file has a different File Size 
or Modification Date and is on local system.

9. Dragging thumbnail to title bar of catalog will force a refresh of the record regardless of the status of the linked file.    This 
operation refreshes all the fields including the thumbnail image but does not change the Notes field.    Linked file must be 
on local system for this to work properly. 

10. Ctrl+right click on thumbnail to copy record to the current (selected) catalog.    The copied record is appended to the end of
the target catalog.    You must have a source and a target catalog open to use this command. This operation will not work if 
you first select the thumbnail of the record that you want to copy from. 

11. Ctrl+Shift+right click on thumbnail to copy record to the current (selected) catalog and add a delete sign to the source 
record.    The copied record is appended to the end of the target catalog. You must have a source and a target catalog open 
to use this command.    This operation will not work if you first select the thumbnail of the record that you want to copy 
from. 

12. Shift+right click on thumbnail to bring up the Get Image From URL dialog.    Use this command to access the Get Image 
from URL dialog if you have selected “Don’t ask again this session”. 

13. To replace the thumbnail image only, Open a source and a target catalog. Select the source and the target thumbnails with a
mouse click. Press the Ctrl + Shift keys and press the left mouse button over the source thumbnail while dragging the 
thumbnail onto the title bar of the target catalog. Releasing the mouse button replaces the target thumbnail with the source 
thumbnail.      This operation only replaces the thumbnail image in the target record.    The text data fields are untouched.    
This is useful for making title thumbnails for index catalogs, movies, sounds and other files that have no representative 
image. 



Marking Records
Alt+left mouse click marks and unmarks a record.    Unlike the File Explorer, Kudo Image Browser catalog marks are 
retained after a catalog open and close operation.    To remove marks you must unmark them.    

Shift+left mouse click on two records marks and unmarks all records between the clicks.    The first click selects the first record 
but doesn’t mark until you have completed the second click.    The cursor changes to a checkmark until the second click is 
completed.    Unlike the marking files in the File Explorer, Kudo Image Browser catalog marks are retained after a catalog 
open and close operation.    To remove marks you must unmark them. To remove all marks use Find to find all marks and 
shift+left click on the first and last record of the found set of marked records.    If necessary, use the Home and End keys to go 
to the beginning and end of the found set of marked records.    



Unlock Kudo
Opens the Kudo Unlock dialog.    Enter the unlock code for the designated machine to unlock Kudo. 



Buy Kudo
Opens the Buy Kudo dialog.    Provides order form, ordering options and generates an unlock request key for this machine.      
The unlock request key is used to create the unlock code for this machine.    The unlock code will not work on another machine.



Kudo Web Site
This selection in the Help menu will connect you to the Kudo Web site.    Kudo will start your Internet browser and input the 
URL of the Kudo site (www.imspace.com).    The Kudo Web site offers free Kudo updates and the latest information about 
Kudo products and techniques. A collection of Kudo catalogs created by professionals for distribution is also available for 
download and will give visitors an idea of the publishing opportunities available to Kudo users.



Catalog Publisher's Web Site
You can add an Internet shortcut or HTML file to your catalog to give your catalog users a quick and easy way to connect to 
your Web site from inside the catalog.    Or you can add a simple jump to your Web site from the Help menu.    Visit the 
Customizing Catalogs topic for more information.



Open Kudo Viewer

Opens Kudo Image Viewer 



Open Kudo Inet

Opens Kudo Internet File Browser .



About Kudo 
Opens the Kudo About Box.    Provides credits and copyright information.



Kudo Splash Screen
Opens the Kudo splash screen.    Provides useful version information and status of application.



Toolbar Buttons
To identify the toolbar buttons in the list below move your cursor on top of the button and a legend describing the purpose of 
the button will appear.    Visit the topics named below to get more information.

Create a new catalog 

Open an existing catalog 

Add Images to a catalog 
Print 

Delete the selected record 

Paste record from clipboard 

Display thumbnails in 60 by 60 pixels 

Display thumbnails in 120 by 120 pixels 

Display thumbnails with text 
Open the Viewer and display images full size 

View the found set of images in the slide show 

View the found set of images in the screen saver 
Display thumbnail record properties 

Find and show records 

Find and show all records in the catalog 

List help topics

Backwards fast Riffle view 

Forwards fast Riffle view 
Display About Screen

Open Kudo Image Viewer 

Open Kudo Internet File Browser 



Display Order of Thumbnail Records
The Sort order of records in a Kudo catalog is the same as the display order. 

Thumbnail records in a newly created catalog are displayed in the order they were added to the catalog. This order is called 
Creation Order. The catalog Creation Order is important for many operations because it creates a sort based on the record 
number. To convert the display order of the catalog records to the Creation Order select Create Catalog From Found Set 

from the Edit Found Set menu of Kudo Image Browser .

After a catalog has had records deleted, the display order changes because deleted thumbnails leave an empty space that is filled
up with other thumbnails when the catalog is compacted.    The resulting order is called the Physical Order and represents the 
actual order that the thumbnail records are saved to the hard disk.

To change the display order of thumbnail records use the Sort menu options. The Kudo Image Browser Sort menu provides 
many sort options.    The selected sort order persists when the catalog is closed.      If you want a display order that is not 
available from the Sort menu options you must create an ad hoc order.

There are many ways to create ad hoc order for the thumbnail image records in a Kudo catalog.    It is easy to change the file 
name of the record and image file to change its sort order and sort by filename. The filename sort is preserved when the catalog 
is closed.

Another way to create simple ad hoc order that can’t be achieved with the Sort menu is to drag and drop (or Ctrl+right click) 
the catalog records to a new catalog.    The ad hoc order now becomes the record creation order for the new catalog and will be 
preserved when the catalog is closed.      

You cannot shuffle the thumbnail records within a catalog like you can 35mm slides on a light table but you can shuffle the 

images in the Kudo Image Viewer .    Select View Images from the Edit Found Set menu of Kudo Image Browser 

 and all images in the present found set will display in the Kudo Image Viewer 

.    If you have too many images, select a smaller found set and try again.

Select Show All Images from the View menu of Kudo Image Viewer  to arrange the images in rows to fit the main 
Kudo Image Viewer window.    Add images to a new catalog in the order you want with a Crtl+Right mouse click.



Editing Record Notes and text fields
You can edit a individual record’s Name, Location, Volume and Notes text fields.    To edit an individual record’s text fields, 
open a catalog and click on a thumbnail with the left mouse button to select it.    Choose the Edit Thumbnail Info selection 
from the Edit Record menu and use the keyboard edit keys to edit the text.    Improper editing can cause you to lose normal 
catalog functions, such as, View Image, so be especially careful to enter valid information.

To perform batch edits of text fields you must choose the appropriate selection in the Edit Found Set menu.



Saving Your Catalog
Kudo automatically saves each record that you edit or update and automatically rebuilds your search index.    The catalog will 
be compacted when it has been changed more than 10%.    Kudo will also automatically rebuild your search index    (the .HSN 
file with the same name as the catalog) if it is missing or if Kudo detects that it has become corrupt.



Moving and copying Records Between Catalogs
Use drag and drop or Ctrl+right mouse click to copy thumbnail records between catalogs. You can also use copy and paste.    
Kudo Mouse Commands 

The Cut (Ctrl+X), Copy (Ctrl+C), Paste (Ctrl+V) and Delete commands are used to edit records in the Kudo catalog.    You 
can also access these commands from the Edit Record menu.    These commands transfer the Kudo record to and from the 
Windows Clipboard.    Use these commands to move and copy records between catalogs.

The Cut command copies the record to the clipboard and adds a delete sign.    The Delete command adds a delete sign. 

The Edit Record commands can transfer Kudo catalog records between Kudo catalogs.    These commands behave differently 
when used to copy and paste images and media files linked to the thumbnails to Windows applications. 



Contacting Technical Support
Visit www.kudo.com to purchase Kudo, drop off e-mail, get gratis updates, find out about special offers, download sample 
catalogs, get more HTML export templates and find answers to frequently asked Mac and Windows users questions.

Fax your questions to 619-272-4292. 

Only registered users receive telephone support.



Updating a catalog

Kudo Image Browser  will automatically update all the records in a catalog when you drop the folder, selected files or 
shortcuts onto the Kudo icon or the open Kudo catalog window.    Kudo will add new files to the catalog and update the existing
files in the current catalog if the modification date is more recent and the file path is unchanged.    This update should not affect 
the Notes field.

To force an update of individual records, drop each record on the Kudo Image Browser title bar. 
To force an update of just the thumbnail images choose the Edit Found Set menu Refresh All Thumbnails selection.

Kudo Image Browser  can automatically find a linked file that is not in the path shown in the thumbnail record location
field.    Kudo can find a file that has been moved to the same path as the most recently accessed file in the catalog, or to the 
same path with a different drive letter, or to the folder where the catalog or Kudo Image Browser executable are.    

Right clicking a thumbnail will update the record path and display the found file. Double left clicking will open the found file in
the associated application.    An error will result if the file is not found.    If there is no associated application no error message 
will be given.

If the file has been moved or deleted from the local file system and there is a URL in the Kudo record, then you can copy the 
remote file to the local path shown in the location field.      Right click on the selected thumbnail image to copy the file from a 

remote file system.    The Kudo Internet File Browser  will copy the file to the path in the location field of the 
thumbnail image record and display the file in the Kudo Image Viewer 

.
Cataloging a moved file will create two instances of the file in the catalog.    Each record will link to files at the different local 

paths. Kudo Image Browser  will not remove the old file record.    

If you have moved the file you should tell Kudo Image Browser  to update it for you by right clicking on it and showing 
Kudo the new file location.    This avoids having to copy the Notes field to the new record.



Title Bar

The Kudo window’s Title Bar displays the name of the open application (in this case, Kudo Image Browser ) or the 
path/filename of the catalog or both.    The Kudo catalog window’s title bar displays the name of the catalog.



Thumbnail Information
The List View , displays the record’s thumbnail image and Notes field.

Click the Info Button  to display image file properties.    When the Properties window is open, click other thumbnail 
image records to display their properties. 



Selecting Catalog Records
Selecting Kudo catalog records for further processing is almost identical to selecting files in the Windows File Explorer.    You 

can mark records with the mouse or you can select records with a Find  operation.    The only difference between the 
File Explorer and Kudo is that with Kudo marked records stay marked after a catalog is closed.

§ Left click on a thumbnail to select the record or its linked file for further processing.    This selection does not survive a 
catalog close.    Some mouse commands only work on the selected record.    The copy record to current catalog 
command will not work if you select the source record with a left click.

§ Alt+left clicking on a thumbnail marks and unmarks a record.    Unlike the File Explorer, Kudo Image Browser record 
marks are retained after a catalog is closed.    To remove marks you must unmark them.

§ Shift+left click on two records marks and unmarks all records between the clicks.    The marked range becomes visible 
after you have completed the second click.    Unlike the File Explorer, Kudo Image Browser record marks are retained 
after a catalog is closed.    To remove marks you must unmark them.

§ Performing a Find command on the current catalog results in a found set of records.    The search criteria for the Find 
command can include marked records.

§ Ctrl-right clicking copies the record to the current catalog.    This is a fast way of creating category sub-catalogs from a 
master catalog.    



Using Drag and Drop with Explorer

Automatically start the New, Open, and Add Image to Catalog File commands of Kudo Image Browser  when you 
drag files or directories from the Windows Explorer and drop them on Kudo, This also works with Kudo Image Viewer 

 or any OLE server application. 
Click on the title bar of the chosen media file or the icon, filename or directory and drag the selection to the title bar of the open 
Kudo Image Browser window or the open catalog window.



Scrolling Shortcuts
Using the scroll bars to move through a large Kudo catalog can be slow.    To instantly scroll through your current Kudo catalog 
found set use the special keyboard navigation keys: 

§ Home To get to the first record of the catalog found set.

§ End To get to the last record of the catalog found set.

§ PageUp To scroll up in page increments.

§ PageDown To scroll down in page increments.

§ ArrowUp To scroll up in row increments.

§ ArrowDown To scroll down in row increments.



Keyboard Menu Shortcuts
Keyboard shortcuts to Kudo Image Browser menu commands.

File 
Menu

Open Catalog Ctrl+O

 

Double left click on catalog from File 
Explorer

Close Catalog Ctrl+W Click on window close.

Add Images Ctrl+U

 

Drag selected files/folders from File 
Explorer and drop on catalog title bar

Print Catalog Ctrl+P  

New Catalog Ctrl+N

 

Right click on desktop or File 
Explorer, select New and Kudo50 
File Type.

Exit Kudo        Alt+F4

Edit Record 
Menu
Cut thumbnail                   Ctrl+X

Copy thumbnail Ctrl+C

 

Paste thumbnail Ctrl+V

 

Delete thumbnail Delete

 

Undelete thumbnail    Ctrl+Q

View Menu
Small Gallery Ctrl+S   

Gallery 

Ctrl+G 

List 

Ctrl+L 

Tree                           Ctrl+T



Image 
Menu
Viewer Ctrl+E 

Properties 

Ctrl+I 

Find 

Ctrl+F 

Find all 

Ctrl+A 

Reveal Images Folder Ctrl+R

Help    F1  context sensitive help.

What’s This?            GUI help



Thumbnail Image Resolution
Kudo automatically creates catalogs composed of thumbnail images that represent the image content of the original media file.   
Files with no image content such as sound are represented with a placeholder image.    Kudo will substitute a default thumbnail 
image if no image is available in the media file.

Kudo catalog thumbnails are 120 by120 pixels with 8 bits color.    Set your video graphics adapter to the highest possible 
quality to help ensure good quality thumbnail images.



Troubleshooting
Most problems can be solved via one of the steps below:

· Read the Kudo Help file for a description of the operation you are trying to perform.

· Download and install the latest version of your Kudo product from www.kudo.com.

· Don’t start a big batch imaging process when your graphics memory resources are less than 50%.    Monitor your system 
graphics memory resource via the GDI memory status on the Kudo Image Browser cataloging progress bar and Kudo 
Image Viewer menu bar.

· Change or update your system video drivers via the Windows control panel to 24 bits (millions) of colors.    Visit our 
Windows Tech Support FAQ page for links to common video card manufacturers driver update download pages.

· Setup Kudo to open your favorite imaging application or image editor when you left double click the image you want by 
changing the file type association for opening the file from the Windows Explorer View Options File Type menu 
selection.    You can also select the image file in the Windows Explorer and right-click on the file while you hold down 
the Shift key. When the menu opens, select Open With. Locate and select the program you want to associate with this 
file type.

· Visit http://imspace.com/techie.htm for more complete support information.



System Requirements
To run Kudo Internet Multimedia Suite v5 you need a Win95/98/NT4 system. We recommend that you not run Kudo on a 
Windows NT Server. Your default Internet Browser can be Navigator but you must have an Internet connection and Internet 
Explorer v3 or v4 installed to make full use of Kudo’s Internet functions. You should also have a video display set to thousands
(16bits) or millions (24 bits) of colors. Simultaneous viewing or playing of many image or media files takes a lot of system 
memory. We recommend at least 32 Mbytes of system memory.    If you routinely work with video and large image collections, 
get the fastest machine and as much system memory as your budget will allow. 



Internet Explorer Settings
Kudo creates thumbnails and displays files from the Internet. That means that Internet connection problems, weird ActiveX or 
Java applets, logon passwords and numerous other problems can interfere with the normally and automatic error free cataloging
process.    Kudo will usually stop the process, give error messages and ask for operator intervention when a problem occurs. 

When cataloging Web pages or HTML files you should set your Internet Explorer to only load image and text information.    
Internet Explorer v4 users benefit because Kudo automatically changes the settings during the cataloging process.    Many 
Web pages have Java programs, ActiveX controls, sound files or other plug ins that require operator intervention to finish 
loading the Web page. Set Internet Explorer v3 to speed up the cataloging process by changing the View Options General 
menu selection to not load sounds or movies.    You can further speed up the cataloging process by changing the View Options 
Security menu selection to not allow downloading of active content, disable ActiveX controls and scripts and disable Java 
programs. 



Filenames in Kudo Catalogs

During the catalog record creation process, Kudo Image Browser  puts the Windows filename in the Kudo catalog 
record Name field if the filename has 29 characters or less. Kudo replaces the Windows 256-character filenames with the DOS 
8-character filenames if the file being cataloged has more than 29 characters. 

The filename consists of all characters to the left of the rightmost period.    All Windows and DOS filenames also have a 3-
character suffix to the right of the last period.    Windows filenames can now support multiple periods because Microsoft is 
transitioning Windows to support UNIX filename conventions.
The Kudo catalog record Name field contains the entire DOS or Windows filename (as seen in the "Info Box" filename) even 
though the catalog Gallery View may only display a part of the filename because of space limitations.

The Find dialog box can use up to 38 characters to search the Kudo catalog record Name fields. However, Kudo does not map 
the 8-character DOS filename to the 256-character Windows filename, so if your search does not return the record you need, try
using the first 4 characters of the filename in the Find dialog box to match the DOS version of the filename.



Supported File Formats
Kudo will catalog the following file formats with its Import Filters listed below.    Kudo will convert most image formats to the 
following formats with its Export Filters listed below. This information is taken from the file KUDO32.INI that is distributed 
with Kudo and may not be the most recent.

[Kudo32ImageBrowserImports]
AI    - Adobe Illustrator EPS=MEPS32.FLT,.AI

ASD - Astound File Format=MASD32.FLT,.ASD

AVI - Microsoft Audio-Video Interleaved=MAVI32.FLT,.AVI

CDR - Corel > v.3 Internal Document Format=MCDR32.FLT,.CDR

CDT - Corel > v.3 Internal Template Format=MCDR32.FLT,.CDT

CMX - Corel > v.3 External Document Format=MCDR32.FLT,.CMX

CPT - Corel Paint Template Format (TIF)=MTIF32.FLT,.CPT

DLL - DOS/Windows Dynamically Link Libraries=MEXE32.FLT,.DLL

DOC - Microsoft Word Documents=MDOC32.FLT,.DOC

DOT - Microsoft Word Templates=MDOC32.FLT,.DOT

DWG - AutoCAD >Rel.12 Internal Document Format=MDWG32.FLT,.DWG

EPS - Encapsulated Postscript Files=MEPS32.FLT,.EPS

EXE - DOS/Windows Executables=MEXE32.FLT,.EXE

FON - Font Library Format=MTTF32.FLT,.FON

GIF - CompuServe Graphics Interchange Format=MGIF32.FLT,.GIF

ICO - Windows Icons=MICO32.FLT,.ICO

JPG - JPEG file=MJPEG32.FLT,.JPG

JPEG - JPEG file=MJPEG32.FLT,.JPEG

JPE - JPEG file=MJPEG32.FLT,.JPE

KDB - non compressed Kudo Katalogs=MKDB32.FLT,.KDB

KDN - compressed Kudo Katalogs=MKDN32.FLT,.KDN

MPG - Motion Picture Experts Group Format=MMPEG32.FLT,.MPG

MPEG - Motion Picture Experts Group Format=MMPEG32.FLT,.MPG

MID - Midi Audio Format=MMIDI32.FLT,.MID

MOV - Apple QuickTime Movie=MMOV32.FLT,.MOV

PCD - Kodak Photo CD Files=MPCD32.FLT,.PCD

PCT - Macintosh Picture Format=MPICT32.FLT,.PCT

PIC - Macintosh Picture Format=MPICT32.FLT,.PIC



PCX - ZSoft PC Paintbrush Bitmap=MPCX32.FLT,.PCX

PDF - Adobe Acrobat File Format=MPDF32.FLT,.PDF

PNG - Gif24 / PNG File Format=MPNG32.FLT,PNG

POT - Microsoft Powerpoint Templates=MPPT32.FLT,.POT

PPT - Microsoft Powerpoint Files=MPPT32.FLT,.PPT

PSD - Adobe PhotoShop 2.5 Format=MPSD32.FLT,.PSD

TGA - Truevision Targa File Format=MTGA32.FLT,.TGA

TIF - Tag Image File Format=MTIF32.FLT,.TIF

TTF - True Type Font Format=MTTF32.FLT,.TTF

WAV - Microsoft WAV Sound File Format=MWAV32.FLT,.WAV

WMF - Microsoft Windows Metafile Format=MWMF32.FLT,.WMF

XLS - Microsoft Excel Documents=MXLS32.FLT,.XLS

XLT - Microsoft Excel Template=MXLS32.FLT,.XLT

[Kudo32ImageBrowser - Exports]
GIF - CompuServe Graphics Interchange Format|*MGIF32E.FLT=*.GIF

JPG - JPEG file Format|*MJPEG32E.FLT=*.JPG

PNG - Portable Network Graphics Format|*MPNG32E.FLT=*.PNG

Contact Imspace Systems for additional formats.    Send us representative samples of files that you want us to support or files 
that you are having problems with.



Buying Kudo
Kudo Internet Multimedia Suite v5 free version is a freely distributed full featured version that installs in evaluation mode 
and converts to Reader Mode after the 30 day evaluation period.    The Catalog Reader mode has all features except cannot 
make or edit image catalogs. 

Please take the time to properly evaluate Kudo before purchasing. If you are going to make CD-ROMs or manage multimedia 
file collections in a Mac/Windows cross platform environment, then we recommend purchasing a license to use Kudo Image 
Publisher.

Purchase an unlock code to convert your installed Kudo Internet Multimedia Suite v5 free version to the full registered 
version.    Select the “Buy it Now” button from the Kudo Image Browser startup screen, fill out the form and choose one of 
the purchasing options.    

A Kudo Certificate can be traded for an unlock code. You can purchase a Kudo Certificate via our online order form at 
www.kudo.com or call the Kudo order desk at 619-272-2600 from 8-5 PM Pacific Standard Time.    You can also purchase a 
Kudo Certificate from your favorite reseller.



Sharing Kudo catalogs with others
Kudo catalogs and the media files they link to can be shared on a local area network.    This is useful for publishing media file 
collections to a workgroup such as a group sharing image files for creating page layouts on a magazine or newspaper. This 
method of sharing gives good control over the shared media and catalog files. Users cannot change the catalogs or media files 
without your permission.

To share you must put the files on a shared volume and make the catalogs and the media files Read Only.    The limit to the 
number of users able to share the catalogs is determined by the resources of your network.

Contact Imspace Systems to purchase multiple user licenses or a site license in order to use shareable catalogs on a local area 
network.

You can also share catalogs on a Web page.    Kudo catalogs linked to your Web page will open when clicked if the user has 
Kudo installed.    Kudo users can search Kudo catalogs and retrieve media files over the Internet or Intranet.    Visit 
http://imspace.com/newcats.htm to see our sample Kudo catalogs in action.

To share Kudo catalogs on removable media, such as, diskettes, Zip and Jaz cartridges or CD-ROMs put your catalogs on the 
volume with your images or linked to images stored on your FTP server or Web site.

When you put your catalogs on a diskette or Zip cartridge with your image files Kudo will find the images regardless of the 
image file location referred to in the catalog.    The image files need to be in the same directory as the catalog or in the same 
relative path on the removable volume and Kudo will find the files automatically for drag and drop and viewing operations.    
Kudo will ask for help if it cannot find the image file.

The relative path is the same path but with different DOS drive letter.    For example, most CD-ROMs are drive letter D, E or F.  
When you map a network volume the drive letter may vary from the last time you mapped it.    Kudo will search the relative 
path of all mounted volumes if the image file is not in the absolute path or in the directory with the catalog or in the Kudo 
Image Browser directory.

Relative path searching applies to drag and drop operations between Kudo applications and from catalogs to Windows 
applications.

When you share catalogs you may want the catalogs to have your unique identity.    You can make the catalog user know that 
the catalog came from and belongs to you.    Catalogs can be locked.

Custom opening screens, movies or sounds can be distributed with the catalogs. 

Catalogs can be linked to remote FTP and HTTP file systems on the Internet.    Sales and marketing information can be put in 
the catalog and prospective customers linked directly to your automated Web Store. 

Publishing on local networks 

Publishing Kudo catalogs on the Internet 

Publishing catalogs on CDROM 

HTML Export 

Printing Your Catalog 

Export Catalog to Macintosh 

CD Publisher 

Create Virtual CD-ROM 

Customizing Catalogs 



Publishing catalogs on local networks
To share Kudo catalogs and images on a local area network you must put the files on a shared volume and make the catalogs 
Read Only.    The only limitation to the number of users able to comfortably share catalogs on your network is the network 
resources.

Don’t forget that Kudo catalogs are linked to image or media files and the link must be preserved when you move files that are 
in a catalog.    It is best to use the Move command in the Edit Found Set menu to preserve the links to the original files.

Contact Imspace Systems to purchase multiple user licenses or a site license to share catalogs on your local area network.



Publishing Kudo catalogs on the Internet
You can publish the Kudo catalog as HTML .    You can put the catalog file on your site for people to open.    To see examples of
these two catalog publishing techniques visit http://imspace.com/samples.htm and http://imspace.com/newcats.htm. 

Catalogs and thumbnail records can be linked to FTP servers and Web sites.    Sales and marketing information can be put in the
catalog and prospective customers linked directly to your automated Web Store. 



Publishing catalogs on CD-ROM
To share Kudo catalogs on removable media, such as, diskettes, Zip and Jaz cartridges or CD-ROMs put your catalogs on the 
volume with your images or linked to images stored on your FTP server or Web site.

When you put your catalogs on a diskette or Zip cartridge with your image files Kudo will find the images regardless of the 
image file location referred to in the catalog.    The image files need to be in the same directory as the catalog or in the same 
relative path on the removable volume and Kudo will find the files automatically for drag and drop and viewing operations.    
Kudo will ask for help if it cannot find the image file.

You must purchase a Kudo Image Publisher license and get written permission from Imspace Systems before you can include 
Kudo executables as a component of a product for sale. The foregoing is not a restatement of the Kudo license agreement. For 
complete details refer to the license agreement for the product or contact Imspace Systems.



Customizing Catalogs
Customizing thumbnails

To replace the thumbnail image only, hold down the Ctrl+Shift keys and drag a selected thumbnail onto the title bar of another 
catalog. Select the source and target thumbnails before the drag operation and make the current (uppermost) catalog the drop 
target.    This operation only replaces the thumbnail image in the target record.    The text data fields are untouched.    This is 
useful for making title thumbnails for index catalogs, movies, sounds and other files that have no representative image. 

Customizing appearance, behavior and features of catalogs

You can make an image, Web page or, movie or sound file display or play when a catalog is opened.    The image file should be 
a Windows BMP file 500x308 pixels in 8-24 bits colors and named after the catalog with a BMP extension (CATALOG.BMP) 
and belongs in the same directory as the catalog..    

To make a generic splash screen for all the catalogs in a folder, name it SPLASH.BMP.    The SPLASH.BMP file will open 
when you double click on a catalog unless a CATALOG.BMP exists. CATALOG is the name of the catalog file. The same 
naming and location convention applies to WAV files.    SPLASH.AVI will not work.    CATALOG.AVI will work.

Create a CATALOG.INF file to add a URL, advertising message, limit the size of files for display, add a keyword/folder name 
dropdown selection list specific to each catalog. The CATALOG.INF is an ASCII text file with the name of the catalog and the 
extension INF.    A typical CATALOG.INF file is:

MAX=

MAXMESSAGE=

 FINDMESSAGE=This image is available for $79.99 by calling 800-555-5552.

WEBPAGE= http://www.stockpix-photos.com

KEYWORDS=

word1

word2

word3

LOCATION=

root1\folder\folder1

root2\folder\folder2

root3\folder\folder3

In the INF file all text to the right of the = should be lower case and ended with a hard return.    If you don’t use a function leave
the text to the right of the = blank.    The finished file should have no empty lines and be less than 64 Kbytes. 

Use BBEdit on your Mac and save as a DOS file or Word or Notepad on Windows and save as TXT only.    Name is 
CATALOG.INF where CATALOG is the filename of the CATALOG.KDN file. The CATALOG.INF file goes in the directory 
with the CATALOG.KDN file. 

MAX=000000000    (Number must be 9 characters., for example, 010000000 says 10 Mbytes is the maximum size of image file
in this catalog to be displayed by Kudo.)

MAXMESSAGE= (up to 255 characters explaining why the customer can’t display images larger than MAX= file size.    Most 
commonly because the images are meant for placement in page layout applications and are too large for viewing.)

FINDMESSAGE= (enter up to 255 characters explaining that the original image is not available until they call you and give 



you money)

WEBPAGE= (enter your URL here to enable a simple jump to your Web page from the Help menu,)

KEYWORDS= (column of keywords of up to 128 characters each separated by a return.    This is the dropdown Keyword list in
the Find dialog.    The keyword list is also used in the Notes Field Add Keywords dialog in the Edit Found Set menu of Kudo 

Image Browser .    The list is automatically sorted and is letter case insensitive.)

Word1
Word2
Word3
LOCATION=(column of folder names of up to 128 characters each separated by a return.    These names are used for the 
dropdown File location list in the Find dialog. The list is automatically sorted and is letter case insensitive. )
Folder1

Folder2

Folder3

Putting images into folders that are named for the image category, such as pictures of animals in the folder labeled animals, can 
provide an easy way to add searchable keywords to the Kudo thumbnail record.    The image categories can become keywords 
added to the Notes field and also to the Keywords dropdown list via the INF file.    The keywords can easily be added in 
batches based upon their resident folder name.

Before adding keywords in batches you should add the list of categorical folder names to the CATALOG.INF file under the 
LOCATION= and the KEYWORDS=.    

To add keywords in batches create a catalog of the images in categorical folders and search for the folder names via the File 
Location selection in the Find dialog.    Use the Notes Field Add Keywords dialog in the Edit Found Set menu of Kudo 

Image Browser  to add individual keywords to the found set.      When you are done the catalog users will be able to 
easily search for and find images in your catalog based upon keywords in the dropdown selection list.

If you already have words keyed to the image filename in an external database you can import them into the Kudo catalog using

the Database Import Tool from the Tools menu of Kudo Image Browser .    Add the keywords to the CATALOG.INF 
file and you have a dropdown selection list.

All text to the right of the = should be lower case.



Using Kudo with Popular Windows Publishing and Editing Applications
Image intensive page layout, batch image editing, Web site creation and management, digital photography and any process that 
requires choosing from large collections of image and media files can benefit from Kudo.    

Use Kudo catalogs to find and select images and open them in image editors or insert them into documents for printing or 
publishing on the Internet.

To insert an image into a document page, such as Word, open a source Kudo catalog and a target document side by side. 
Depress the Ctrl key and drag the source image thumbnail onto the target document while holding down the left mouse button. 
Releasing the mouse button over the target document should make the image appear in the document at the cursor position.

Drag and drop a thumbnail onto the title bar of an application to open the linked image file in an editor. 

If the drag and drop operation is unsuccessful use copy and paste (Ctrl-C & Ctrl-V).

Netscape Navigator, Page Mill, Front Page and Hot Dog are good drop targets for Kudo.

The Microsoft Office suite of business applications works well with Kudo catalogs.    Kudo also catalogs all office documents 
and Web pages.

Adobe PageMaker, PhotoShop, Premier, Illustrator, and Page Mill are well-behaved drop targets for Kudo catalog users.

Corel Draw, PhotoPaint, Designer and WordPerfect Office suite are good Kudo targets. Kudo supports most Corel file 
formats.



Customer Services
Imspace Systems Corporation, the publishers of Kudo software, provides custom CD-ROM, Web site and software 
development services.    Visit http://imspace.com for more information.



Index Catalogs
The index catalog is a catalog of catalogs. The index catalog is useful when the collection you are managing or publishing has 
multiple catalogs or CD-ROMs.      Index catalogs can avoid the CD-ROM catalog shuffle and allow users to go directly to the 
CD-ROM that has the desired catalog and images.

To add a catalog to a catalog, use the Add Images To a Catalog from the File menu.    Drop a catalog file on the title bar of a 
catalog to add it to that catalog. You can also drop a folder of catalogs on the open Kudo Image Browser window to create an 
index catalog of all the catalogs in the folder. 

The thumbnail that appears in the index catalog is the first one in the linked catalog.    This first thumbnail behaves similar to 
the title frame of a movie. You can replace the title thumbnail with a more representative thumbnail from another catalog.

To replace the thumbnail image in an index catalog:

· Open a source and a target catalog

· Select the source and the target thumbnails with a mouse click.

· Press the Ctrl + Shift keys and press the left mouse button over the source thumbnail while dragging the thumbnail onto 
the title bar of the target catalog. 

· Releasing the mouse button replaces the target thumbnail with the source thumbnail.    

This operation replaces the thumbnail image in the target record.    The text data fields are untouched.    This is useful for 
making title thumbnails for index catalogs, movies, sounds and other files that may have no representative image. 

This technique creates a catalog that can be used to manage a collection of catalogs.    This is a convenient way to organize 
collections that span several Internet sites or CD-ROM/hard disk volumes.    Sub-catalogs can be organized into meaningful 
categories according to content, location or accession order.    Proper organization of sub-catalogs can greatly simplify searches.

Add keywords to the Index catalog with the Editing Record Notes and add keyword and file location selection lists to help users
easily find the desired catalog that contains the images of interest.

During the install process the Kudo installer will look for and copy one catalog having INDEX in the beginning 5 characters of 
the filename from the /Win_kudo folder of a Kudo v5 CD-ROM.    The index catalog is copied to the /KudoIMS5/Catalogs 
folder of your hard disk.    The index catalog will automatically open when you start Kudo for the first time.    If there is no 
index catalog in the /Win_kudo folder then the first catalog is copied to the hard disk during the installation process.



Drag and Drop Images from Kudo
To use Kudo to simplify the process of inserting a picture into an application document:

· Open the catalog and the document window side by side. You can also position the catalog window on top of the 
document. The source image record and the target document must be visible to the mouse cursor. The linked image file 
must be on the local system.

· Press the Ctrl key and hold the left mouse button down on the desired image record while dragging the image onto the 
open document window. 

· Release the mouse button and the file that is linked to the Kudo thumbnail should appear in the application document at 
the cursor position.    

· If the drag and drop operation is not successful, try copy and paste. Use the keyboard shortcuts, Ctrl+C on the selected 
source thumbnail and Ctrl+V on the selected target document. Select the source and target with the mouse cursor.

· If copy and paste operation is not successful, note the file name and location and use it to insert or open the image from the
target application. 

Drag and drop a thumbnail onto the title bar of an application to open the linked image file in an editor. 

When performing a drag and drop operation, the expected behavior of the dropped thumbnail depends on the drop target.    If 
the drop target is the title bar of Word, then Word will try to open the linked image file rather than insert the image into the 
document. If the drop target is the title bar of a Kudo catalog, then the record is appended. If the drop target is the source 
catalog title bar, then the record is updated.

Attempting to insert or open files with formats (EPS, TIFF, JPEG, etc.) not supported by the target application can cause 
unexpected results.

The thumbnail images in the Kudo catalog are linked to files on the local or remote file systems.    Drag and drop (or copy and 
paste) requires the linked file to be local.      Right click on the selected thumbnail image to retrieve the linked file from a remote

file system.    The Kudo Internet File Browser  will get the linked file and put it on the local system in the location 
described in the file Location field.

Kudo takes advantage of Windows technology (DDE and OLE) which allows you to drag and drop images, media files and 
documents into all popular media publishing and editing applications.    Supported applications include Adobe, Microsoft, Corel
and Imspace Systems products.    Kudo drag and drop supports virtually all leading applications including the Kudo Image 

Viewer  and Kudo Image Browser 

.



Using Copy and Paste
For applications that do not support drag and drop, you can insert an image from a Kudo catalog into a target document using 
copy and paste.

To use copy and paste, click on the title bar of the source catalog.    Copy the selected thumbnail by simultaneously depressing 
the Ctrl+C keys.    Click on the titlebar of the target application or document and simultaneously depress the Ctrl+V keys.    
The linked file should open in the target application.    Copy and paste operations use the Windows clipboard and should not be 
used with files that are very large relative to the amount of available system memory.

To use Copy and Paste from the Edit Record menu of Kudo Image Browser :

§ Select the thumbnail image.

§ Choose ‘Copy’ under the Edit Record menu.

§ Kudo will find the original image file and copy it to the clipboard.

§ Open the target document.

§ Choose ‘Paste’ under the Edit menu of the target document.

Your target application will paste the image onto the document page or open another document.

Copy and paste is slower than drag and drop.    Trying to paste an image or media file not supported by the target application 
may cause unexpected results.



Using Your Kudo Catalog
Visit the topics in the list below to learn more about using your Kudo catalogs.

Using Kudo with Popular    Applications 

Kudo Mouse Commands 

Keyboard Menu Shortcuts 

Scrolling Shortcuts 

Opening a Catalog

Add Images to a Catalog

Adding a Single File to the Catalog 

Updating a catalog 

Drag and Drop Images from Kudo 

Using Copy and Paste 

Sorting the Records 

Display Order of Thumbnail Records 

Printing Your Catalog 

Converting catalogs to HTML 

Sharing Catalogs with others 



Adding a Single File
The easiest way to add a single file or folder to a catalog is using drag & drop.    From the right hand side of the Windows File 
Explorer, select the file or shortcut you wish to add to your catalog.    Drag and drop the file or shortcut onto an open Kudo 
catalog.

Another way to add a single file is to choose Add Images to Catalog from the File menu. 




